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About This Release

ABOUT THIS RELEASE
This document describes the enhancements for Image Scout. Although the information in this document is current
as of the product release, see the Hexagon Geospatial Support website for the most current version.
This release includes both enhancements and fixes. For information on fixes that were made to Image Scout for
this release, see the Issues Resolved section. For information on enhancements, see the New Technology section.
This document is only an overview and does not provide all of the details about the product's capabilities. See the
online help and other documents provided with Image Scout for more information.

IMAGE SCOUT
As a viewing and analysis tool, Image Scout allows you to combine multiple images into a virtual mosaic for
seamless smooth roam over a vast and complex area. Using Image Scout, you can perform complex queries on
spatial and attribute data from various sources and produce numerous views of highly sophisticated maps in a
single GeoWorkspace. Furthermore, Image Scout lets you print those map views on a single sheet and add
borders, marginalia, and other finishing touches.
Image Scout is composed of three different Hexagon Geospatial products:
•

GeoMedia Professional: An enterprise GIS that is the perfect tool for collecting and analyzing GIS data,
populating an enterprise database, and turning information into precise finished maps for distribution and
presentation. Includes a complete Grid tool kit for spatial and distributional analysis of any kind of gridded
data, including raster, elevation, LiDAR and others. Extensive Help examples direct the user to many
different types of analyses such as: hot spot analysis, least cost routing, contour generations and many
more.

•

GeoMedia Image Professional: Provides image light table capabilities for creating virtual mosaics, image
enhancements, image comparison, image annotation, research and negation, directed search over linear
and area features, and much more: based on Overwatch Systems' Image Light Table Plus (ILT) product.

•

GeoMedia GeoDEX: A viewing and analysis tool for geographic information providing the capability for the
user to create MGRS grids and work with specialized image data sets such as CADRG, CIB, and others.

Image Scout 3D also includes the following product:
•

GeoMedia 3D: Provides an integrated 3D visualization and analysis environment. You can visualize,
navigate, analyse, and interact with 3D data natively in GeoMedia. In addition, you can dynamically
integrate surfaces, imagery, feature data, and vector data to provide a 3D view of all data sources in a
GeoMedia 3D map window.
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New Platforms

NEW PLATFORMS
LICENSING
Starting with the Power Portfolio 2018 release, licenses are no longer be based on Certificate-file based
technology. Instead, licenses are based on Activation IDs, allowing you to activate products without providing Host
IDs or other hardware-related parameters. You can also re-host without emailing the licensing team for assistance.
The Power Portfolio 2018 release also includes improved tools that make it easier to install licenses, set up license
servers, and provide more professional error handling. Finally, the Power Portfolio 2018 release includes improved
customer notification in the products, such as an “end of subscription” message in the Start-up screen. These more
secure and automated processes, along with a new licensing portal, provide you with a better overall user
experience.

IMPACTS
GEOWORKSPACES
GeoWorkspace files from GeoMedia 2016 and previous may be opened in GeoMedia 2018. GeoWorkspace files
saved with GeoMedia 2018 cannot be opened in GeoMedia 2016 and previous.

NEW TECHNOLOGY
GEOMEDIA PROFESSIONAL
NEW TECHNOLOGY (16.1)
DATA ACCESS
POSTGIS DATA SERVER
The PostGIS data server now better supports multi-table read-write views of various kinds, and supports queries
against the picklist table.
The PostGIS data server now filters out feature classes which have table and field names containing uppercase
characters. Such characters require special syntax in SQL and are not supported within GeoMedia.

WMS DATA SERVER
The WMS data server now automatically recognizes and handles certain Coordinate Reference Systems as being
defined with swapped axes (e.g. Y-X rather than X-Y). It is no longer necessary to add an .ini file entry to convey
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the need to swap axes, in most such cases. The .ini file entry is still available for cases in which the software
misinterprets the CRS, or in which the WMS site results don’t match the CRS.

WMTS DATA SERVER
The WMTS data server now automatically recognizes and handles certain Coordinate Reference Systems as
being defined with swapped axes (e.g. Y-X rather than X-Y). In addition, an .ini file entry is now available for cases
in which the software misinterprets the CRS, or in which the WMTS site results don’t match the CRS.

ORACLE LTT DATA SERVER
Further changes to optimize LTT-specific queries for Oracle 12c have been made to resolve performance issues.
These are beyond the changes in GeoMedia 16.1 for CR# 1-S0AO0B.

DATABASE UTILITIES
We’ve improved the PostGIS capabilities within Database Utilities, as well as changed the definition of the
GFeatures view to filter out feature classes which have table and field names containing uppercase characters.
Such characters require special syntax in SQL and are not supported within GeoMedia.

FEATURE CACHING
LOGGING
An optional log file may be created, and if present the feature caching system will provide diagnostic information
about whether and how caches are being used at runtime.

IMPROVED PERFORMANCE
IFC files that are created with GeoMedia Desktop 16.1 are organized for even better performance, especially for
cases of very large files accessed over a network share. Previously published feature cache files remain
compatible, but performance will improve if the files are newly published.

COMPATIBILITY WITH ADVANCED FEATURE MODEL
On the New Warehouse Connection command as well as the Properties dialog of the Warehouse Connections
command, the “Enable advanced feature model” and “Enable feature caching” checkboxes are no longer mutually
exclusive. The performance improvements that come with feature caching are now available for AFM-configured
warehouses as well.
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DATA OUTPUT
OUTPUTTOTABLESERVICE
OutputToTableService now provides a .DisableTransactions property which, when set to True, causes the object
to avoid all BeginTrans, CommitTrans, and Rollback operations. Control of transactions is left completely to the
calling application.

ANALYSIS
SPATIAL INTERSECTION COMMAND AND SPATIALINTERSECTIONPIPE
SpatialIntersectionPipe and the Spatial Intersection command that uses it, now transmit the individual key
definitions of the incoming recordsets into the output query as a composite key.
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SPATIAL MODELING
RUN SPATIAL MODEL COMMAND
This new command integrates spatial models into GeoMedia. It allows the user to select a model (.gmdx file)
created through the Spatial Model Editor utility; fill in any parameters in the model dynamically, especially features
input to the model from the GeoWorkspace; and then see the various results from the model added to the map
within the GeoWorkspace.

EXPLORER WINDOW
A new “Spatial Models” entry in the Explorer window lets you easily see what spatial models have been run within
the GeoWorkspace, and to manage them by rerunning them, changing their names and other properties, and
deleting them. You can also see the various results of the run, and display them in a map or data window.
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SUPPORT FOR SPATIAL MODEL RESULTS IN COMMANDS
Many commands in GeoMedia which present features for selection through a feature treeview control, now support
the selection of spatial model results in addition to feature classes, queries, categories, and the like. In such
cases, a new “Spatial Models” branch appears in the tree, with each spatial model in the GeoWorkspace visible
beneath it. Expand a model and then select the various results for processing.

Commands which support selection of spatial model results include: Add Legend Entries, Add Thematic Legend
Entry, New Data Window, Change Data Window Contents, Output to Feature Classes, Attribute Query, Attribute
Selection, Join, Union, Spatial Query, Spatial Intersection, Spatial Difference, Buffer Zone, Analytical Merge,
Aggregation, and Functional Attributes.
To use spatial model results within commands that do not yet support them directly, output the results to a feature
class via Output to Feature Classes, or build a query on the results via Attribute Query that passes through all of
the features.

SAMPLE SPATIAL MODELS
The default spatial models folder (C:\GeoWorkspaces\SpatialModels) now contains sample models that
demonstrate use of certain operators and demonstrate how to construct a model properly for use with the Run
Spatial Model command.
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SPATIAL MODEL EDITOR
This utility has been upgraded to the latest version released with ERDAS IMAGINE 16.1.

ADVANCED FEATURE MODEL
AFMCONVERTSERVICE
AFMConvertService is a new component that provides the ability through API to convert a standard non-AFM
warehouse to a warehouse configured for the Advanced Feature Model. This capability was previously available
only through GUI.

COMPATIBILITY WITH FEATURE CACHING
On the New Warehouse Connection command as well as the Properties dialog of the Warehouse Connections
command, the “Enable advanced feature model” and “Enable feature caching” checkboxes are no longer mutually
exclusive. The performance improvements that come with feature caching are now available for AFM-configured
warehouses as well.

NEW TECHNOLOGY (16.2)
GENERAL
APPLICATION WINDOW
The name of the active GeoWorkspace is now displayed in the caption of the application window at all times,
whether the active map, data, or layout window is maximized or not. Previously the GeoWorkspace name was
shown only when a child window was not maximized.

INVOKECOMMAND METHOD
The method InvokeCommand on the Application object now supports invocation of the Select Tool command.

COORDINATE SYSTEMS
GEODETIC DATUMS
Support for the following datums has now been added:
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•
•
•
•
•

Oman National Geodetic Datum 2014. This addition includes support for use of ONGD14 with UTM zones
39-41 North. It also includes autodt.ini support for 7-parameter datum transformation between ONGD14
and WGS84 (ITRF89).
Geocentric Datum of Australia 2020. This addition includes support for use of GDA2020 with MGA (UTM)
zones 46-59 South. It also includes autodt.ini support for 7-parameter datum transformation between
GDA1994 and GDA2020.
Ross Sea Region Geodetic Datum 2000.
NAD83(NSRS 2011) and associated PA11 and MA11. This addition includes support for use of
NAD83(NSRS PA11) with Hawaiian State Plane 1983 zones and NAD83(NSRS 2011) with other State
Plane 1983 zones, as well as use with various UTM zones.
Rauenberg Datum/83 and Potsdam Datum/83. Standardizes support for Gauss-Kruger (3 degree) zones
and 7-parameter datum transformations to ETRS89 that were previously emulated.

EPSG CODES
EPSG support has now been updated from version 8.8 to version 9.0 of the geodesy dataset. EPSG added 139
new Coordinate Reference System codes; this release adds support for 110 of them (those unsupported are CRS
types not intrinsically supported in GeoMedia, such as Engineering or Vertical-only CRS).

DATUM TRANSFORMATIONS
A new transformation is now introduced which streamlines the number of steps needed in a transformation path
involving one of the example Named Datum entries associated with the NAD83 geodetic datum in the United
States. This improves performance for large datasets.

DATA OUTPUT
OUTPUTTOTABLESERVICE
For the Access data server only, as a consequence of Create Table committing any open transaction in Access,
the new transaction-disabling logic will now begin a new transaction after the Create Table. For this scenario, the
calling application must delete the created table itself, when performing rollback logic.

MAP DISPLAY
THEMATIC LEGEND ENTRIES
On the Legend Entry Properties dialog for Unique Value and Range thematic legend entries, the column header
over the on/off checkboxes in the thematic class grid can now be used to turn on and off the entire set of
checkboxes together. Click on the column header to toggle the checkbox for the topmost row, and to set all other
checkboxes to the same value. Click again to reverse the settings for all classes.
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If a Unique Value or Range legend entry is not displayed in the map window, and the legend window is used to
display one of its child legend entries representing a thematic class, the parent legend entry will now automatically
have its display turned on so that the thematic class is displayed in the map.

SPATIAL MODELING
SAMPLE SPATIAL MODELS
Additional sample models for raster data have been introduced.

NEW TECHNOLOGY (16.5)
GENERAL
SETUP
This Release Guide is now available directly from the Start menu.

SAMPLE DATA
Some obsolete sample data has now been eliminated from the delivery. This includes both GeoWorkspaces and
Access warehouses.
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All remaining sample GeoWorkspaces have been upgraded to GeoMedia Desktop 16.5 format.

DATA ACCESS
GEOPACKAGE DATA SERVER
A new read-write GeoPackage data server has been introduced with GeoMedia 16.5. It supports the OGC
GeoPackage 1.2 Encoding Standard, which includes geospatial extensions to SQLite. Like the Access data
server, it provides a personal, portable, free, file-based warehouse type which requires no separate software
installation or licensing.
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The GeoPackage data server is supported in most parts of all three tiers of the GeoMedia Desktop, with the
exception of the following:
•
•
•
•
•

The library system
The catalog system
The grid system
The PublishIFC utility
Output of static labels

NEW WAREHOUSE COMMAND
This command now supports GeoPackage warehouses in addition to Access warehouses, and provides a
warehouse template for both. The default new warehouse type is now GeoPackage.
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DATABASE UTILITIES
Support has been added for GeoPackage warehouses.

BATCH PUBLISHING FOR POSTGIS
PostGIS warehouses are now supported for batch feature cache publishing through the
DataSourceMonikerCreator.exe and PublishIFC.exe utilities. This also means that PostGIS warehouses are
available for shared/enterprise cache configurations.
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GML DATA SERVER
A new read-only GML data server has been introduced with GeoMedia 16.5, replacing the previous GML data
server. It supports data conforming to the OGC Geography Markup Language (GML) specification.
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Several new connection options are provided on the Advanced button.
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Key features of this new GML data server:
•

•

Improvements in the logic of parsing and translating GML structure into GeoMedia feature classes,
resulting in broader compatibility and significantly-reduced connection time. The default strategy is to use
the schema from the GML header to compose most of the feature classes definitions needed for
GeoMedia at connection time. But in cases in which the schema is not available, not useful, or incorrect,
the data server can be set to ignore the schema and try to compose the feature classes definitions directly
from the GML structure.
The NO_GEOM_CSFFOUND option available for the previous GML data server (corresponding to the “If
no matching coordinate system is found for a feature instance” group of the “Advanced Options” dialog
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•

•

•

box) has been retired and is ignored if passed to the ConnectInfo parameter through API. The GeoMedia
feature model does not support GML files with features of the same feature class having different
coordinate systems. The new GML data server assumes that the first feature found within a feature class
sets the coordinate system for the whole class. The benefit of this assumption is a much shorter
connection time, especially with GML having multiple feature classes.
Overriding the coordinate system is possible for incorrectly-defined GML files. The user can input a valid
EPSG code or a CSF file, and the new coordinate system definition is applied to all feature classes from
the GML file.
The data server will respect the axis order according to the standard EPSG or CSF definition. If the GML
file does not respect the axis order (for example files with the EPSG:4326 coordinate system in which
latitude-longitude is expected but longitude-latitude is what is provided), options for swapping the
coordinates are available.
In cases when the schema associated with a GML file is not available, not useful (i.e. does not completely
describe the GML structure), or incorrect, the user has options for identifying a different schema file or
ignoring the schema. When ignoring the schema, the connection time increases because the data server
must read most of the GML file to discover its structure.

The data server better handles very large GML files that have produced many “out of memory” errors in the past.
When dealing with large files (greater than a default threshold), a disk cache is created and the memory footprint of
GeoMedia is considerably reduced. The default value for this file size limit is set at 500MB. Because performance
degrades when using a disk cache instead of memory, this setting can be increased by the user if the computer
has enough RAM to accommodate the data.

WFS DATA SERVER
A new read-only WFS data server has been introduced with GeoMedia 16.5, replacing the previous WFS ReadOnly data server. It supports data conforming to the OGC Web Feature Service (WFS) specification.
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Several new connection options are provided on the Advanced button.
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Key features of this new WFS data server:
•
•

•

•

It provides the same advanced GML parsing and translation logic as the GML data server, for extensive
compatibility with different WFS services.
It includes a new connection dialog for setting the coordinate systems associated with feature classes, so
INI files and the NOCSFFOUND connection option of the previous WFS Read-Only data server
(corresponding to the “If no matching coordinate system is found for a feature class” group of the
“Advanced Options” dialog box) are no longer necessary.
The user can select which feature classes are visible in GeoMedia. This is useful when only certain
classes are needed from a WFS service, and it results in shorter connection times. This also can be used
to filter incorrectly-defined feature classes that could cause errors in operation.
The HTTP request timeout can be increased for slower internet connections or for older WFS services not
supporting paging operations for transferring data.
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DEFINE WAREHOUSE CONFIGURATION FILE UTILITY
This utility no longer offers the ability to define or edit INI files for the WFS Read-Only data server. The new WFS
data server offers the convenience of connection parameters provided exclusively within the connection syntax,
with no external file required.

DATA CAPTURE
SELECT SET PROPERTIES
The Select Set Properties command now remembers the position, size, and column widths of the dialog across
sessions.

OFFLINE EDITING
The commands Output to Offline and Post from Offline now support GeoPackage warehouses as the offline
connection.

SPATIAL MODELING
SPATIAL MODEL EDITOR
This utility has been upgraded to the latest version released with ERDAS IMAGINE 16.5.

NEW OPERATORS
New operators have been introduced for performing geoprocessing on feature data, which are borne out of certain
GeoMedia capabilities. These are found in the new Feature Analysis and Geometry Creation operator categories,
and include:
•
•
•
•
•

Generate Functional Attributes and Define Functional Attribute operators, analogous to the Functional
Attributes command and corresponding pipe.
Intersect Features operator, analogous to the Spatial Intersection command and corresponding pipe.
Mask Features operator, analogous to the Spatial Difference command and corresponding pipe.
Merge Features operator, analogous to the Analytical Merge command and corresponding pipe. This
operator replaces an earlier operator implementation by the same name, which had limited capabilities.
Create Centroid and Create Centerpoint operators, providing efficient access to these capabilities also
provided through the Generate Functional Attributes operator.
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EXPRESSIONS WITHIN OPERATORS
For those operators which use functional attributes (Generate Functional Attributes and Merge Features), there are
additional expression functions beyond those available in GeoMedia. Those operators, listed by function category,
are:
•

•

•

Geometry
o BUFFERRING – returns a buffer ring from and to certain distances from the given geometry
o BUFFERZONE – returns a buffer zone at a certain distance from the given geometry
o CONVEXHULL – returns the convex hull of the given geometry
o FITTEDBOUNDINGBOX – like the MBR function, but with the box oriented to optimally fit the data
o STROKE – returns a polyline geometry with any input arcs stroked at 5-degree intervals
Math & Trig – these are the hyperbolic equivalents to existing trigonometry functions
o ACOSH
o ASINH
o ATANH
o COSH
o SINH
o TANH
Misc
o CHOOSE – provides a more compact and easily used alternative to nested IF functions
o DECODE – evaluates a set of conditions and returns the first condition evaluated to true
o SPLIT – splits a text string into multiple text strings using a given delimiter
o TOP – returns the top (highest) n values from a set of values
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For the most part, the expression syntax used in these new Feature Analysis operators matches that of GeoMedia,
which permits direct use in Spatial Modeler of expressions from GeoMedia functional attribute definitions.
However there is not 100% compatibility, so be aware of these differences:
•
•
•
•

It is necessary to explicitly cast content instead of counting on an implicit cast, because of internal
technology changes and because of the possibility of data loss occurring without user awareness when an
implicit cast is performed.
The STATUS function is not provided, it has no role to play in the spatial modeling context.
The FORMATATTRIBUTE function is not provided, attributes do not have metadata for display formatting
in the spatial modeling context.
The LOOKUP function has moved from the Statistical function category to Misc.

ENHANCEMENTS TO EXISTING OPERATORS
Features Input operator is enhanced to support PostGIS databases.
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Features Database Output operator is enhanced to support PostGIS databases.
Preview operator is enhanced to support Vector geometry fields (called Compound geometry fields in GeoMedia).

OTHER NEW OPERATORS
Numerous other new operators have been introduced beyond those mentioned above that are analogous to
GeoMedia functionality. Many come from an ERDAS IMAGINE heritage, and include operators for processing
many types of data – raster, feature, point cloud, and more. For more information see Spatial Modeler help.

SAMPLE SPATIAL MODELS
The model “BufferAndMerge” has been altered to employ the new Merge Features operator.

February 13, 2018

27

New Technology

GEOMEDIA IMAGE PROFESSIONAL
IMAGE LIGHT TABLE PLUS 2018
Image Light Table Plus 2018 has been integrated with this release of GeoMedia Image Professional. Image Light
Table Plus 2018 includes the following new and enhanced features:
New Radar/SAR Improvements
•
•
•

Logarithmic display option for DRA/Histogram tool window
Persist SAR metadata when saving to NITF
Sentinel-1 support

New Geo Accuracy Improvements
•
•
•

Common Sensor Model (CSM) support
Geography Markup Language (GML) support
NITF-embedded elevation data support

Display and Performance Improvements
•
•
•
•
•

Softcopy Image Processing Standard (SIPS) support
Enhanced platform/context-specific default display settings
Optional antialiasing during reduced resolution creation
Support for new Sharpen and TTC families and members
High resolution display improvements

New and Improved Data Formats
•
•
•
•

DIMAP V2 image tiling support
KOMPSAT-3 support
KOMPSAT-3A support
Sentinel-1 support

Usability
•
•
•
•
•

Apply DRA based on Regions of Interest
Ability to reset Don't Show Again warning dialogs
Explanded File Open Preview dialog image metadata
Optionally create reduced resolutions during save
NITF File and Image subheader metadata display

GEOMEDIA GEODEX
None
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GEOMEDIA 3D
SAVE AND LOAD IMPORT 3D OBJECTS SETTINGS
The ability has been added in the Import 3D Objects command to persist (in user-definable XML files) the settings
used for the command.

PREDEFINED STYLES
GeoMedia 3D now delivers a set of predefined styles.

FIRST PERSON VIEW
The First Person View enables a navigation mode that simulates a walk through the 3D scene. It displays what a
person would see when turning around, looking up or down, or walking straight ahead. A new slider is also
provided to allow dynamic adjustment of the field of view value.

LATIN-1 (ISO-8859-1) CHARACTER ENCODING
The ability has been added in the Import 3D Objects command to use alternate Latin-1 (ISO-8859-1) character
encoding during model file parsing rather than the default UTF-8 encoding.

LOCAL ORIGIN DEFINITION FOR TRIMBLE SKETCHUP FILES
The ability has been added in the Import 3D Objects command to define the local origin latitude and longitude
values when the embedded origin is missing from a Trimble SketchUp Model file (1-K1PFTD).

DEFINE COORDINATE SYSTEM FOR HEXAGON POINT CLOUDS
Hexagon Point Cloud (HPC) files should be encoded with proper coordinate system metadata. However, in cases
where such files do not contain this metadata, the Insert HPC Footprints command now allows the user to define
a coordinate system (1-XNRVQ6).

SYSTEM REQUIREMENTS
Computer/ Processor

Minimum 4 core Intel 64 or equivalent, 8 core or more recommended

Memory (RAM)

4 GB (dual channel systems) or 6 GB (triple channel systems) minimum, 8 GB (dual channel
systems) or 12 GB (triple channel systems) or more recommended



4 GB for software



Data storage requirements vary by mapping project1

Disk Space
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Minimum display resolution 1600 x 1200. 4K Ultra HD monitors are not currently supported.
LCD <= 5 ms, higher refresh rate recommended
Graphics Boards

Dual monitors recommended
Graphics cards with 1 or 2 GB dedicated video memory, NVIDIA recommended
Graphics cards for stereo mode – Stereo capable NVIDIA™ Quadro

Software security (Hexagon Geospatial Licensing) requires one of the following:


Internet connection for online license activation



Ethernet card for offline license activation



One USB port for hardware key for offline license activation

Peripherals

Optional Installation:


Logitech® Dual-Action® Controller for GeoMedia 3D component of Image Scout 3D



Windows® 7 SP1 or higher, Professional and Ultimate (64-bit)



Windows® 10, Professional and Enterprise (64-bit)



Microsoft® .NET Framework 4.5



Microsoft® .NET Framework 3.53



Microsoft Primary Interoperability Assemblies 20054



Oracle® Server 11g, 32-bit and 64-bit, at least version 11.2.0.4



Oracle Express 11g, at least version 11.2.0.4



Oracle® Server 12.1



Oracle® Server 12.2



SQL Server® 2012, 64-bit



SQL Server® Express 2012



SQL Server® 2014, 64-bit



SQL Server® 2014 Express



SQL Server® 2016, 64-bit



SQL Server® 2016 Express



SQL Server® 2017, 64-bit

Operating Systems2

System Dependencies

Database Server Engines
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SQL Server® 2017 Express



PostgreSQL 9.3 with PostGIS 2.1



PostgreSQL 9.4 with PostGIS 2.2



PostgreSQL 9.6 with PostGIS 2.3



Oracle Client 11g, 32-bit5



Oracle Client 12.1, 32-bit5



Oracle Client 12.2, 32-bit5



SQL Server Native Client 10.0 or higher6

Database Client Engines

SYSTEM REQUIREMENTS NOTES
1

Disk I/O is usually the slowest task in geospatial data processing. Faster hard disks improve productivity.
Reading data from one disk, writing temporary data to a second disk, and writing data to a third disk improves
performance. Disk arrays improve productivity but some RAID options slow performance. Network disk drives are
subject to network limitations.
2

32-bit versions of the Windows operating systems are not supported. Image Scout runs on 64-bit systems in 32bit emulation mode.
3

Required for GeoMedia 3D only. For information on installing .NET Framework 3.5 for Windows 10, see the
Installing .NET Framework 3.5 (Windows 10 only) section in the GeoMedia 3D Installation Guide.
4

To install, right-click on <root-media>\Repository\Image Scout\GM 3D\Prerequisites\vs_piaredist.exe and select
Run as administrator.
5

Oracle Data Access Components (ODAC) is required if using the Feature Accessor option for Oracle in the
PublishIFC utility, or if using the Database Utilities utility to manage an Oracle warehouse. ODAC is normally
delivered by the Oracle Client Administrator installer, but not by the Oracle InstantClient installer. ODAC contains
many components, of which PublishIFC requires the Oracle Data Provider for .NET, and Database Utilities
requires the Oracle Provider for OLEDB.
6

The SQL Server Native Client 10.0 or higher is needed in order for the Database Utilities utility to automatically
create the correct GeoMedia metadata for date, time, and datetime2 data types when using a SQL Server or SQL
Server Spatial warehouse. You may get SQL Server Native Client 10.0 or higher from the corresponding Microsoft
websites. If the SQL Server Native Client is not installed on the system, you will need to manually choose Date as
the data type from the dropdown combo box for these data types in the Feature Class Properties dialog and set
the format properly.

February 13, 2018

31

Issues Resolved

ISSUES RESOLVED
GEOMEDIA PROFESSIONAL
ISSUES RESOLVED (GEOMEDIA 16.1)
CR #

SUMMARY

Description / How to Reproduce

Intersection does
not work with offset
temporary
construction lines.

Using offset when digitizing with the Intersection snap enabled does not work with the construction lines
displayed for the offset.

86726
_GM

Steps to reproduce.
1.

Open the IntersectionSnap.gws and correct the path to the City.mdb.

2.

Insert a county_street feature using an offset of 500 and select mutiple creek features to
display the construction lines.

Start digitizing and select an intersection of the construction lines and see how the Intersection snap
glyph does not appear or work.
With further investigation, this is caused by an issue in the Oracle Dataserver.

1LJ3K3
P

Error in GWM
CreateLegendEntry
Graphic due to an
issue in the Oracle
Dataserver.

GeoMedia
application may
hang when using
Properties on
Windows 8.1 or
Windows 10.

1LI3G2
M

The properties control may hang GeoMedia on certain operating systems. It has been observed that on
Windows 8.1 and Windows 10, that when interacting with other applications, if the user clicks on the
Cancel option on the Properties dialog then the application may hang. Specifically, the application
hangs if the control does not have focus (top highlighted in blue) when the Cancel option is selected.
Workflow (Windows 10):
1.

Start the GeoMedia application, with features displayed in map window (USSampledata.gws
for example).

2.

Start a secondary application such as Process Monitor.

3.

In GeoMedia Map Window, double-click graphic feature to invoke Properties dialog.

4.

Click on the secondary application to make it active (leaving Properties dialog open in GM).

Click the Close option on the Properties control (without giving focus to control).

1QNNZ
K5

For GM Map
Publisher, the
queued edit Map
Window is not
displaying

February 13, 2018

GeoMedia Desktop 16.00.0000.01405 and GeoMedia Map Publisher 16.00.0000.00012
There is an issue with the displayed results appearing in the Queued Edit Map Window, specifically:
1.

The original geometry is not displaying in the Queued Edit Map Window.
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Generalize Results
correctly.

2.

The CDRGeometry (conflict reference geometry) is not displayed in the Queued Edit Map
Window.

The conflict geometry and original geometry are not appearing as dashes.

1QRXT
3F

CAD data server
fails to serve
TextPointGeometry
for AutoCAD TAGs
(block attributes).

An SR was filed asking for assistance in serving the Text geometry that is associated with TAGS from
an AutoCAD Block (as is displayed in AutoCAD itself). However based on testing thus far this doesn’t
appear to be possible despite the fact that the ‘AutoCAD Scanner Design Specification’ document
indicates that the TAG type should be mapped to TextPointGeometry.
Specifically the Native-to-GDO Geometry Type Mapping table in the ‘AutoCAD Scanner Design
Specification’ document shows the Native Geometry Type of ‘TAG’ (described as “Attributes that are
attached to block entities in the drawing file.”) mapped to the GDO Geometry Type of
‘TextPointGeometry’. However attempts to serve the TAG attributes from the customer provided dwg
file as text results in 0 geometries for the TextGeometry legend entry.

Copy Parallel >
Snap to point
doesn't place line
on point.

1JP60JI

Copy Parallel > Snap to point doesn't place line on point.
Try to copy an Interstate through a city out of USSample Data set.
1.

Start Copy Parallel

2.

Identify Interstate for Copy Parallel

3.

Snap on City point to copy parallel

The snap won't be accepted. The Interstate is not copied parallel through the citypoint, instead it is
copied in the vicinity.

1MJA88
J

OpenRecordset
with
gdbOpenSnapshot
and spatial filter
results in an empty
recordset for
PostGIS GDO.

Opening a recordset with a combination of gdbOpenSnapshot type and any valid spatial filter results in
an empty recordset being returned. Attached is a sample .NET application demonstrating the issue.

Select set
problems when join
displayed.

When a Join is displayed, the user may notice incorrect select set display in the map window while
interacting with corresponding data view. The problem seems to be display only but can be confusing.
It does not occur in version 6.1 but is latent to 2014.

1D0B8
O8

For example, the user might have the following entries on the legend:
•

States

•

Join of States and Counties

The user may select the record for Arizona in a States data table, but both Arizona and Utah will be
selected in the map view.

1L7FF1
D

Shared cache
appears to be
slower than
Exclusive cache

February 13, 2018

Customer has created Oracle trace files that they believe indicates that the Net (Shared) caching is
slower than Local (Exclusive) caching due to parsing of query statments for indexes, views, and tables.
The trace files created by the customer are included in the attached zip file and TKPROF file. The
problem description provided by the region as taken from the SR is shown below.
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due to query
parsing.

We have received a TKPROF file (GM_startup_prod.tkp) from the customer made for the startup of a
workspace (which looks directly in Oracle view), where they note that a lot of time is spent on parsing
statements that query for indexes for the various views and tables.
It accounts for a significant amount of the total startup time. If you look at the summary for nonrecursive statement at the bottom of the TKPROF file you can see that almost 24 seconds are spent
parsing.
Would it be possible to reduce time spent parsing by using bind variables?

Reverse Direction
does not work on a
secondary
geometry, it
reverses the
unselected primary
geometry.

Secondary geometries are not reversed when using the Reverse Direction command from the Vector
tab or when using the Reverse command from the Geometry Information context menu. Here is the
workflow to reproduce the problem:
1.

Extract the attached ReverseGeometry.zip file and then open the ReverseGeometry.gws that
has an Access connection to the ReverseGeometry.mdb file.
a.

1QJA89
D

When the .gws is opened, note that the legend contains two entries for the feature
class named LineFeature and its associated secondary geometry named
‘Geometry2 of LineFeature’. The primary geometry for the feature class is
displayed in red and the secondary geometry in blue. Additionally a style is applied
with an arrow symbol indicating the direction of each geometry.

2.

Use the cursor to click on one of the secondary geometries in the map window (i.e. the red
geometry). Note that only the secondary geometry is shown in the select color (e.g. green
highlight).

3.

Now choose the Reverse Direction command from Vector > Edit on the ribbon bar. This will
result in the reversal of the primary geometry even though it was not selected, while the
secondary geometry which was selected remains unchanged. This is apparent because the
arrows for the blue primary geometry style are reversed, but the arrows for the red secondary
geometry are still pointing in the original direction.

This same behavior is observed with the Reverse command when accessed via Geometry Information.
For instance select the red secondary geometry, then choose the Geometry Information command and
right click on the ‘PolylineGeometry’ node, then choose Reverse from the displayed context menu. As
before, the primary geometry will be reversed, but the selected secondary geometry will remain “as is”.

Ghost circles
rendered in display
when create
thematic of
polygons
containing arcs
(Regression).

1LRSM
RH

Creation of a thematic mapping with color fill of polygon geometries containing small arc geometry
components may result in color filled circles appearing in both map and layout window displays; the
circles change in distribution and size depending on zoom scale. The problem is not seen in version
2015.
See attachments for screen shot showing comparison between version 2015 and 2016. If the arcs are
removed from the polygon geometries, the problem does not occur in version 2016.
Workflow using data provided in Attachments:
1.

Extract contents of .zip

2.

Use GeoMedia 2016 to open Version2016_Access.gws, correcting path to source
warehouse.

3.

Observe small circles in the map display that change with changes in the display scale.

If review Geometry Information for some of the polygons, you can see that the geometry has arc
components; The geometry seems to pass standard Toolbox > Validate Geometry checks (no problems
are found).

February 13, 2018
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If the arcs are removed the problem does not occur.

Unable to display
(.ecw) WMTS
layers that can be
displayed
successfully in
other applications.

Unable to display (.ecw) layers from ERDAS Apollo WMTS service that can be displayed successfully
in other applications.
The GeoMedia WMTS data server is unable to display certain layers from the ERDAS Apollo Essentials
WMTS service. The same layers can be displayed successfully in other clients using the same
coordinate system (either EPSG:4326 or EPSG:3857).
The layers from the service that fail to display in GeoMedia (but display in the other clients) are
‘sandiego3i_ecw’ and ‘bucuresti_ecw’.
To reproduce the problem, use the steps below.

1M17EF
A

1.

Start GeoMedia and make a new WMTS connection.:

2.

Use Add Legend Entries to add ‘sandiego3i_ecw’ to the legend. A legend entry will be
created with geometry statistics showing one instance.

3.

If you fit the view and click the map window you can see the layer footprint highlighted, but
there is no image/tiles displayed within the footprint.

The coordinate system used in all of the clients was the same (EPSG:4326).
* Note that the ‘sandiego3i_jp2’ and ‘‘sandiego3i_otdf’ layers from the same service can be displayed
successfully in GeoMedia . These layers appear to be the same as the ‘sandiego3i_ecw’ with
presumably a different format for the source imagery (i.e. JPEG 2000 and OTDF respectively). This
means that the problem appears to be specific the ECW format.

WMTS data server
requests/displays
data in wrong
coordinate system
(other clients work
correctly).

1M8DCI
D

The GeoMedia WMTS data server serves the ‘MAPA TOPOGRAFICZNA’ feature class from the WMTS
service with the wrong coordinate system. Specifically the GetTile requests uses the EPSG:4326
TileMatrixSet instead of the default EPSG:2180 TileMatrixSet.
The EPSG:2180 TileMatrixSet appears to be the default since it is the first listed in the GetCapabilities
document and GeoMedia will even show that the coordinate system assigned to the ‘MAPA
TOPOGRAFICZNA’ feature class is EPSG:2180 after it is served using the WMTS data server.
There appears to be a disconnect between the metadata in that Feature Class Definition indicates that
the coordinate system is EPSG:2180 and the actual feature class served which seems to be
EPSG:4326. This problem results in an incomplete display of ‘MAPA TOPOGRAFICZNA’ feature class
in the Map Window and the portion of the data that is visible is warped presumably due to the
coordinate system transformation from EPSG:4326 to EPSG:2180.
The same problem exists even if you use a Warehouse Configuration File (.ini) for the WMTS
connection with the following entry defining the default TileMatrixSet as EPSG:2180.
[TileMatrixSet for Feature Classes]
Default=EPSG:2180

1ANAB
3S

Layout > Print/Plot
> Background
image prints black
(Images with more
than 3 bands).

February 13, 2018

Customer has 6" resolution imagery. These are uncompressed 4 band (32bit) untiled TIFF (tested with
and without overviews) for their service area. They report that the images appear solid black when
trying to output a layout to .pdf or other printing device.
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Open GWS, connect to USSampleData or a blank Access connection. Insert the two Geotiffs. Print to
PDF (Used PDF995 locally) and outputs are black for the images. Also tested with Adobe Acrobat 10
and the local hard copy devices.
Workaround is to give the image feature class (or any feature class displayed on legend) a 1%
translucency. The image plots, looks great.
This is not specific to TIFF images, seen with JFIF and other formats as well.
This is apparently a problem common to all 4-sample-per-pixel data.

1M2V06
J

Errors occur with
multiple commands
when using
PostGIS table
names containing
uppercase
characters.

The PostGIS data server in GeoMedia 2016 does not correctly handle feature class/table names that
contain uppercase letters, resulting in errors. This issue was reported by a customer who states that
the open source PostGIS data server that could be used with GeoMedia 2015 did not have this
problem.

Layout - Text
Placement and
Text Properties >
Support for
OpenType (.otf)
fonts is missing.

There is a failure when displaying OpenType fonts in GeoMedia 2013. Support replicated failure on
both GeoMedia 6.2 and Geomedia 2014.
In versions of GeoMedia prior to 6.1 (5.2, 6.0), this .otf font was available in the drop- down list for text
placement in the Layout Window, and the text was displayed with the proper font. But starting in the
6.1 version, the fonts does not show up in the drop- down list - they are not available for placing new
text in the layout window.
In versions since 5.2 (5.2, 6.0, 6.1, 2013, 2014) right click on selected layout text and then 'Properties'
shows the text properties dialog. In the sample .gws, note that the customer's font is the StencilStd.otf,
and that it displays with bright green color, indicating a non-supported font.. Also note that newly
placed text in a new, blank .gws can also be given the StencilStd.otf font, but that the layout window
does not display the text with this font properly - text appears bright green.

195FG
MS

Thus there are two parts to this issue. One is a regression from 6.0 GeoMedia to later versions – you
can no longer place or display layout text with .otf fonts. The second part is that if the regression was
an intentional change in the product, one should not be able to select .otf font from the layout Text
Properties dialog.
Both parts are resolved if we restore the previous functionality, placement and display of layout text with
OpenType fonts.

1SMHS
UB

Originating Pipe
recordset
open/reopen
spams registry for
GDO configuration.

Opening a recordset through an originating pipe will cause it to check the registry for CacheEnabled
setting for the specific connection type. However, this is accomplished by instantiating a whole new
GDOServerRegEntries object that enumerates the whole HKLM\Software\Wow6432Node\GDO registry
subkey and parses values therein.
The function using the GDOServerRegEntries is: GMConnection::GetCacheFileName, which it does
even if the given connection is created without explicitly enabling caching.
This causes a registry contention in an environment when multiple concurrent GDO requests are being
served, like in a WebMap installation.

1LUTZ6
G

Using WMTS data
server hangs
GeoMedia forcing
the GeoMedia

February 13, 2018

Use of the WMTS data server results in GeoMedia hanging (where there is no response to any mouse
click), thus forcing the GeoMedia process to be killed via Task Manager. This problem seems to occur
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process to be killed
with Task Manager.

most often when using the Zoom In command or the Pan command while WMTS layers are displayed
in the Map Window while already zoomed into the data set.
1.

Open the provided ‘WMTS_Kademo2.gws’ which has a single WMTS connection to the
service used.
There are six layers present in this WMTS and all of the layers are added to the legend and
displayed in the Map Window. The Display Scale for the Map Window is set to 1:2500.

2.

Select the ‘Zoom In’ command and at the prompt “Click to zoom or press and drag”, place a
single data point in the center of Map Window to perform a zoom.
After the data point is placed, the Map Window display starts to update and the ‘Processing
window update…’ message is displayed in the message strip. If you click the ESC key to
cancel the update the wait cursor will disappear and the ‘Processing window update…’
message will be removed, but GeoMedia is now in a completely unresponsive state, so the
only recourse is to kill the GeoMedia process.

* To reproduce this issue a second time you may need to remove the temp files from your user temp
folder (i.e. %TEMP%).

1LTZTT
N

Some WMTS
services are not
displayed.

The WMTS servvices of our customer published by ERDAS APOLLO Ess+SDI are not dispalyed
correctly in the GM. The capabilities document is loaded, but no other picture ("data") is loaded into the
map winddow. Only blank frame is displayed in the GM. It should use EPSG:5514. The capabilities
document containes czech diacritic letters and more tilematrixset.

Update Attributes geometry functions
fail to update.

Any functional expression that updates geometry fails with errors.
Example workflow: Attempting to use Update Attributes to compress a geometry fails in version 2016.
Using a standard COMPRESS(Input.Geometry) to update an area geometry field in 2016 fails with the
following message:
--------------------------GeoMedia Desktop
Update Attributes was unable to update all features. Please refer to log file C:\Warehouses\\States.txt
for details.

1LR7ZL
A

--------------------------Review of the text file shows the following error for each record processed:
“could not be updated. Data type conversion error”
Workflow:

February 13, 2018

1.

Open USSampleData.gws

2.

Vector > Update > Update Attributes

3.

Select States, click in Geometry field and select Expression.

4.

Build expression for COMPRESS(Input.Geometry) then add the expression.

5.

Click OK to run the update.
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Observe the error messages.

1SD94
Q1

1TEDR
0Q

GeometryStorageS
ervice fails to
transform
PolygonGeometry
when run inprocess
from .NET.

A working sample of PolygonGeometry construction and transforming to storage blob by the means of
GeometryStorageService usage was working up to the newest 15.0 release of GeoMedia. When the
same application is recompiled in a 16.0 environment it fails when all the objects (PolygonGeometry,
point and GeometryStorageService) are created inprocess of a .NET application. It does not fail when
run from inside a native COM process like the MapSvr.exe of GeoMedia WebMap.

Attribute Based
Style not correctly
evaluated/displaye
d in GeoMedia
2016.

A customer has a data set that makes extensive use of Attribute Based Styles that displays correctly
(i.e. as expected based on the ABS expressions) in GeoMedia 2015, but when the same .gws is
opened in GeoMedia 2016 the styles rendered are incorrect. In other words the styles do not appear
the same in GeoMedia 2016 as they do in GeoMedia 2015.
One of the issues involves the use of a nested IF expression to assign Color or Override Color based
on the values of One (or Two) attributes.

Attribute Based
Style is incorrectly
displayed in
GeoMedia 2016.

A customer that uses ABS extensively filed a SR stating that the display of the styles in their
GeoWorkspace was significantly different when the .gws was opened in GeoMedia 2016 as compared
to the same .gws in GeoMedia 2015. This CR is filed for an issue with the expressions used by the
customer on the CharacterString property as a means to specify which of several available Font Styles
from a Point Style Collection should be displayed for a particular feature instance.

1LRSQ
EP

Functional nested
IF statement
returns incorrect
results when
evaluating null
values.

User-provided functional expression that works to return valid values for all records in 2015, fails to
return valid values for some records in 2016.

1SLIP4
P

Memory leak
apparent in the
PostGIS GDO.

There seems to be a memory leak caused by the PostGISRW.GDatabase object while opening
consecutive recordsets from the same connection.

GeoMedia /
Webmap memory
error in GML
dataserver.

There is a memory problem in GeoMedia Pro / WebMap Pro when using GML dataserver. Workflow in
GMPro:

1THBC
C0

1SBLPA
3

The user is using a nested IF statement.

1. Open GMPro. The GeoMedia application process memory usage is ~ 50.MB.
2. Create new warehouse connection –using a GML type The GeoMedia application process memory
usage is ~ 250.MB
3. Add EGB_PktGraniczny_copy feature class to the map window. The GeoMedia application process
memory usage is ~ 265.MB
4. Remove legend entries from the legend.
5. Close and delete the GML connection.
GeoMedia application process memory usage remains the same ~ 250.MB.

February 13, 2018
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When using Webmap on our Customers production system we do have a lot of big GMLs that need to
be imported to continuous Oracle database. We suffer OutOfMemory exceptions and HResult
exceptions because of this error described above.
To compare, do the same workflow with Access warehouse type using USSampleData. You will notice
that the memory is being released after closing and deleting connection.

1L4T7S
Q

Features from
spatially filtered
GML connection
fail to display when
GeoWorkspace is
re-opened.

When a GeoWorkspace with a connection to the customer provided GML file has a spatial filter applied,
the features from GML connection will be filtered as expected and the legend statistics will be displayed
appropriately. However if that GeoWorkspace is then saved with the spatial filter in place and then
reopened the features from the GML connection that were filtered will be missing from the Map Window
and the legend statistics will show a value of ‘0’ for the corresponding legend entries.

1S0AO0
B

GeoMedia
performance
problem: Oracle
LTT 12c fails to use
bind variables for
select from
all_indexes.

User testing of GeoMedia version 2015, has noted a potential performance issue while working with
Oracle 12c using GeoMedia Oracle LTT data server. It has been proposed that the performance is due
to GeoMedia’s failure to use bind variables when the GeoMedia Oracle LTT data server issues queries
such as SELECT FROM ALL_INDEXES.

Event
AfterUpdate(vbCan
celed,
objGFeature) objGFeature is not
initialized after first
insert.

This code in VB .NET (AfterUpdate Event):
Private Sub Fnc_AfterUpdate(ByVal vbCanceled As Boolean, ByVal objFeature As PAFM.GFeature)
Handles currentFeatureClassEvent.AfterUpdateHandler
Try
MsgBox("State: " + objFeature.State.ToString())
Catch ex As Exception

1CAJX
WS

MsgBox(ex.Message)
End Try
End Sub
Return exception after insert first feature in GM2015:
Feature must by initialized with either Bookmark or KeyAttributeValues
Notes - GM 2015:
objFeature is not filled with right attributes of new added Feature, witch exist in this moment in DB
next insert of the same feature is OK

1QR3T9
3

After upgrade to
GeoMedia 2016
cannot open a
number of
Geomedia 2014

February 13, 2018

A customer filed a SR reporting that several of their GeoWorkspaces that were created with GeoMedia
2014 cannot be opened successfully in GeoMedia 2016 (i.e. a ‘Failed to open document’ message is
displayed when an attempt is made to open the .gws in 2016.)
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created
GeoWorkspaces.

When attempting to open the .gws in GeoMedia 2016 a number of the map windows are loaded prior to
the ‘Failed to open document’ message, but as soon as the message dialog is dismissed with the OK
button the .gws is closed.
The issue appears to be caused by one specific legend entry. Specifically a unique value thematic entry
named 'Route Shield County Scale' in the Map Window named 'ESZs'. If the 'Route Shield County
Scale' legend entry from this map window is deleted from the .gws while it is open in GeoMedia 2014
and then the .gws is saved without that legend entry, the .gws can then be opened successfully in
GeoMedia 2016.

Desktop 2015
GeoWorkspace
cannot be opened
on Desktop 2016.

1T4DN
WD

Customer reports, support duplicates a problem where a .gws created with vanilla GMDesktop 2015
cannot be opened in vanilla GMDesktop 2016. Workflow to reproduce:
•

Copy attachment 'Tom.gwt' to GMDesktop 2015 templates folder "C:\Program Files
(x86)\Hexagon\GeoMedia Professional\Templates\GeoWorkspaces". Start GMDesktop, new
.gws, select 'tom.gwt' as the template. At this point I made an Access connection to
USSampleData.mdb and added a few legend entries. Exit and save the .gws.

•

On a GMDesktop 2016 system, open the saved .gws. Error appears.

•

Attachment 'joe_15.gws' was created using this workflow and will not open on my
GMDesktop 2016 system.

Creating a new .gws on 2016 using this same template doesn't cause a problem.

1S3NV
RQ

2016 G/Tech
Interface features
not loading Style
Index. Regression
from G/Tech
Interface 2015.

Using GeoMedia 2016 the StyleIndex for some Features imported with the G/Techinterface are not
generated. This results in the displayed Style in the Map to be incorrect. GeoMedia 2015 generates the
StyleIndex.

New
GeoWorkSpaces
NOT saved after
selecting yes to
save.

Users who use GeoWorkSpace template (.gwt) files other than Normal.gwt may encounter problems
saving GeoWorkSpaces upon exiting.

1SDCP
7C

Example workflow using supplied GeoWorkSpace template (.gwt) file:
1.

Create new GeoWorkSpace using the template option.

2.

Use a template other than Normal.gwt.

3.

Optionally do queries etc in the GeoWorkSpace.

4.

Select File > Exit, select Yes to save.

Observation: The Save GeoWorkSpace As dialog does NOT appear. GeoMedia simply exits and none
of the work performed in step 3 is saved. The GeoWorkSpace does not seem to be saved anywhere.

1F5HZ7
Q

GeoMedia
Professional 2015
does not honor
long-press gesture
for "right-click" on
touch screen.

February 13, 2018

GeoMedia Professional 2015 does not respond to typical "right-click" replacement on tablet touch
screen devices (long press).
We are unable to "right click" using the touch screen functionality on our tablet. "right-click" is typically
replaced by a long press and hold on touch/tablet devices using a long press. GeoMedia responds to
double-tap (double-click) and single tap (single-click), but does not react to the right-click/long press
action.
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Right click doesn't
work on
touchscreen under
Windows 8.

17ZHF
QL

On customer's laptop with touchscreen and Windows 8, the right click doesn't work with GeoMedia.
1)

When using a mouse, right-click in GeoMedia works fine.

2)

When using touch screen, right-click in GeoMedia is not working.

Right-click using touch screen in Windows itself (not GeoMedia), is:
•
press the fingertip and hold for a while - first I see a little circle around the place where I
touch, then for a little while it changes into a square and then a dialog appears as expected
When customer tries the same in GeoMedia, they only get the circle around the place where they
touch, but no square, nor any dialog.
Tested this in GeoMedia 13.00.0000.00242.

Animated styles not
updating/shown
with map extent
change.

Animated styles not updating/shown with map extent change.
To reproduce:
-New GeoWorkspace with USSampleData access connection
-Add HighwayInterchange feature class

1U5ND
KZ

-Zoom in so that roughly 1/4 of the features are visible in the map
-Edit the style for HighwayInterchange so that it is animated. Changing the size between 2 frames is
sufficient. Animate upon display with unlimited repetitions.
-After applying the style, note that the features in the map display are animated.
-Zoom out, pan, etc. and note that none of the features outside the initial map extent are displayed until
the style is applied again.
Initially discovered in 16.1..10195 using Oracle RW.

1SD9H9
8

Selecting Attribute
Properties dialog
crashes GM on
German vm
w/German
language package.

Selecting Attribute Properties dialog crashes or hangs GM on German vm w/German language
package.
This hang/crash occurs on German WINDOWS 8 or WINDOWS 12 with the GM German language
package installed. The crash happens if GM is configured as English also.
1. Open USExample.gws
2. Double click on State feature to bring up the Select Set Properties dialog.
3. Don't close the Select Set Properties Dialog
4. Click on Windows Start and GM geoworkspace hangs/crashes.

1LR3G
AX

Attribute Properties
dialog as well as
other dialogs fall
behind other
applications.

February 13, 2018

User has noted that dialogs upgrade from VB6 do not pop to the top when the GeoMedia application is
selected. This can give users the illusion that the application has hung and/or forces users to collapse
all applications in effort to "search" for the hidden GeoMedia dialog.
Problem occurs in both 2015 and 2016 for Attribute Properties.
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Example Workflow:
1.

Open USSampledata.gws

2.

Double-click on graphic feature.

3.

The Properties dialog will appear showing attributes for the feature.

4.

Drag the dialog outside of the GeoWorkSpace document container.

5.

Activate some other application(s) such as MS Word or Notepad, placing the application over
the Attribute Properties dialog. Obseve the dialog is hidden (this is expected).

6.

Now click inside of GeoMedia document giving focus to the GeoMedia application. Notice
that GeoMedia is NOT responsive until you search, find and dismiss the hidden properties
dialog.

Problem also noted for other dialogs such as Map Window Properties.
The user may be able to click on the application in the task bar or possibly use <Alt> <Tab> keys to
force dialog and application back to the top.

1LRSQ
UG

Release Guide
missing
configuration
dependencies for
certain utilities.

The GeoMedia Desktop Release Guide fails to include configuration dependencies for the following:
Database Utilities requires that MS SQL Native Client 10.0 or higher be installed when working with MS
SQL Spatial warehouses. The MS SQL Native Client is normally delivered as part of MS SQL
Management Studio or can be installed as a standalone product.
Oracle Data Access Components (ODAC) is required if using the Feature Accessor option in
PublishIFC Utility. ODAC is normally delivered by Oracle Client Administrative install but not for Oracle
Instant Client.

Tooltips in the map
window only
display while using
the select
command (clarify in
documentation).

When turning on tooltips for legend entries, they only display when the select tool is selected. All other
commands cause the pointer to change (from an arrow to whatever glyph the command uses) and
disables the tooltip display. This causes issues while trying to figure out what event you’re looking at on
the map while using a command such as Interactive Calibration or Move.

Steps to reproduce

1AFI8V
A

•

Open a GeoWorkspace and display a feature in the map window

•

Turn on map window tooltips for that feature. Ensure that the select tool is selected and hover
over a feature in the map window to verify that it is displayed.

•

Switch to a command which changes the glyph (e.g. from the ribbon, Vector > Move). You’ll
notice that the glyph is changed to a crosshair.

Hover over a feature and notice that the tooltip does not display.

1VUIM
MI

Grant Statements
need to be
modified to be
correct.

February 13, 2018

GRANT SELECT ON SYS.GV_$SESSION TO SYSTEM WITH GRANT OPTION;
should be modified to the following:
GRANT SELECT ON SYS.GV_$SESSION TO PUBLIC WITH GRANT OPTION;
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GRANT INHERIT PRIVILEGES ON SYSTEM TO GDOSYS:
should be modified to the following 2 lines:
GRANT SELECT ON SYS.V_$SESSION TO PUBLIC WITH GRANT OPTION;
GRANT SELECT ANY SEQUENCE TO WMSYS; -- allows use of identity based primary
keys in version enabled tables - new in Oracle 12c

1-LJFRUY

1-LQ38PC

WMTS: Support
sites with
swapped
coordinate
systems, via the
INI setting.

ECW images that
displayed
properly in
GM2015 have
their display
corrupted.

WMTS implementation does not currently support the case of a CRS with swapped coordinates. The
INI entry is present (as with WMS) but there is no implementation present.

Customer supplies several ECW images that do not display properly. Images display as basically a
black and grey block, and you must zoom way in to see the rough outline of a feature. This problem
relates to both the CS of the geoworkspace and the size of the image. When in Geographic LL, the
image displays fine. It also displays fine in the Albers custom CS from USSampleData.gws. Image
displays incorrectly in customer's standard NAD83 for S. Louisiana (EPSG3452) To recreate:
•
•
•
•

1-QKE51A

PostGIS GDO
ModificationLog
is not properly
updated after
insert / edit in join
view.

1-R2G9D9

Raster
performance
degradation with
GM 2015 versus
earlier versions.

1WHKTNF

Help Document >
Batch Plotting >
Variable Text
String
Substitution: Help
is unclear

1-UR4591

Insert Feature
fails with cannot
insert record if

February 13, 2018

Open GeoMedia Desktop,
Create a new .gws and create a new warehouse.
Insert one or both of the customer's .ecw files. The files display fine, since the default CS for
a new .gws/.mdb is Geographic.
Load the customer's NAD83 Louisiana SP CS and the image display is corrupted.

If you have a join view defined with an INSTEAD of trigger/function in place, the GDO ModificationLog
table is not properly updated for inserts, edits and deleting. It may be that there is some mistake but
GeoMedia offers no example steps for an INSTEAD of trigger workflow. The trigger works outside of
GeoMedia.

User reports and support duplicates a performance degradation when displaying raster feature
classes in GMDesktop 2015, compared to previous versions of the product. Images that
formerly took about 20 seconds to display now take almost 8 minutes.

The Help for Batch Plotting does not explicitly state that Variable Text String Substitution is only
available via the Sheet Composition workflow. Customer attempted to use the Sheet Selection
workflow with a .gws containing [GM-Date] and [GM-Time] in a template used w/ a layout sheet and
filed an SR when this failed to work properly.

User has MS SQL Spatial warehouse where one or more fields have default values defined in the
database using the Default Value or Binding property in the design view of the table (MS SQL
Management Studio). These default values are properly populated by Insert Feature command in 2015
but Insert Feature in 2016 fails with an error:
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have database
Default Value
defined
(Regression)

"Could not insert a record in the database."
Example:
User has defined default values using functions such as:
(getdate()) : returns the current date for a date field.
(suser_sname()) : returns the MS SQL user name inserting the record for a text field.

These functions work when using Insert Feature in 2015 but fail in 2016. Records CAN however
be inserted into the data grid of the Data Window in 2016 thus the problem may be related to the
Properties control. Additionally records can be inserted with proper default values when using
Interactive Insert Area by Face. Insert Area by Face however fails to properly populate default
values.

GeoMedia hangs
using Geometry
Information on
Windows 8.1 or 10
if focus changes
to another app

A SR was filed reporting that when running GeoMedia Desktop 2015 on Windows 8.1 or Windows 10
the ‘Geometry Information’ dialog falls behind the GeoMedia map window if focus switches to another
application while the ‘Geometry Information’ dialog is displayed. This results in a hang of GeoMedia
that requires the GeoMedia.exe process to be killed via Task Manager.
The customer that reported the issue with the Geometry Information command was using Geomedia
2015 with the German Language pack configured. Reproduced the problem with version
16.00.0000.01405 using the German Language Pack configured as German or as English.
1. On a Windows 8.1 or Windows 10 machine use Geomedia to open USSampleData.gws.
2. Click on a States feature class in the Map Window to select it and then right-click and choose the
‘Geometry Information’ command from the menu.
3. Now that the ‘Geometry Information’ dialog is displayed, switch to another application (the SR
recommended the PDF Reader application which is what I used). If using the PDF Reader application
you can collapse the application window using the minimize button (-) in the upper right corner.
4. Now that the GeoMedia application is visible again, note that the Geometry Information dialog is no
longer visible (it has presumably been hidden behind the map window).

1-VSDFXJ

5. At this point you will be unable to perform any further actions in GeoMedia, thus the
GeoMedia process will have to be killed via Task Manager.

Documentation
typo - Oracle
NUMBER(1,0)
maps to
BOOLEAN.

In the documentation (Using Oracle Connections-> Datatype matching - Oracle to GeoMedia ) we have:
-----------------------------------------------------Oracle Datatype | GeoMedia Data Type
NUMBER (p,s) | Long (p<10,s=0)
----------------------------------------------------When creating table like
CREATE TABLE N ( GM_BOOL NUMBER(1,0) );

1-CF3XHZ

GM_BOOL is mapped to GeoMedia Boolean.
Should be:
-----------------------------------------------------Oracle Datatype | GeoMedia Data Type
NUMBER (p,s) | Long (p<10>1, s=0)
-----------------------------------------------------

1KXGPVS

Documentation >
Help > Feature
Caching

February 13, 2018

While it is true that large volumes of data (raster, point clouds, etc.) are used in GeoMedia, it is
not relevant to Feature Caching. The document needs to be corrected.
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1LWVZPB

Changes to Help
concerning use of
Hypertext fields

Users can right-click in data window or properties dialog to insert a file/path into a field defined as
Hypertext. While this can be useful for stored files, it does NOT allow users to actually edit or define
URL values.

Users can however, press and hold the <Ctrl> key when clicking into a Hypertext field to edit a
URL. This information should be added to GeoMedia Help in the section titled: "Using
Hypertext"

1QKAWM1

GeoMedia 2016
Language Pack
always installs on
Drive C:
(Hardcoded)

GeoMedia 2016 Language Pack installs on Drive C: (Hardcoded), even if GeoMedia has been
installed on drive D:\ This causes the GeoMedia Menu to remain in English language after
configuring GeoMedia to German.

Properties-Window of a feature disappears when using an attribute-hyperlink. After clicking on
the hyperlink, the window disapperars in the back.

1SCRY2U

PropertiesWindow of a
feature
disappears when
using an attributehyperlink.

ISSUES RESOLVED (GEOMEDIA 16.2)
CR #

SUMMARY

1XJZBT
U

Very slow
connection to
Oracle 12C
databases

Delivery issue with
AppDotNETSuppor
t DLL

1YDZQ
D5

Description / How to Reproduce
Problems with poor connection performance for Oracle and Oracle LTT connections when working with
Oracle 12c databases. Patches to address Oracle 12c performance issues were provided for
GeoMedia 2015 and was presumed to be available in GeoMedia 2015 builds 10254 and higher.

Problem is reflected in below stack trace:
Message: System.MissingMethodException: Method not found: 'Void
Intergraph.GeoMedia.GeoMedia.GMApplicationEventPackage..ctor(Intergraph.GeoMedia.GeoMedia.A
pplication)'.
at
Intergraph.EGIS.GeoMediaDesktop.CommandTracking.GeoMediaEditCommandListener.Initialize(Appli
cation geoMediaApplication)
at Intergraph.EGIS.GeoMediaDesktop.StartupCommand.StartupCommand.Initialize(Application
application, Object viewListeners)
Code of
Intergraph.EGIS.GeoMediaDesktop.CommandTracking.GeoMediaEditCommandListener.Initialize does
only one thing before exception is raised: var gmApplicationEventPackage = new
GMApplicationEventPackage(geoMediaApplication);

February 13, 2018
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After investigation we found that on failing machine (it has recent webmap installed) dll did not change
with update to 10267 GM and is the one attached with 1 in extension. On machines where it works, the
one with 2 is present both in:
C:\Program Files (x86)\Common Files\Intergraph\GeoMedia\Program\
and
c:\Windows\Microsoft.NET\assembly\GAC_32\AppDotNETSupport\v4.0_6.1.1.0__9ed92a685a4e3166\
Some clever tools suggest that difference for this method is that type of parameter is coming from
different places.
What is interesting in 10157 setup 30KB dll was delivered, in 10267 – 44KB one. Both share same
version number.

Use of
GeometryStorageS
ervice.GeometryTo
Storage method
crashes in version
16.1

A lot of custom application errors appeared after upgrading to latest version. We managed to isolate the
problem with this simple VB classic code:
Dim g As Object
Dim objPol As Object
Dim objP As Object
Dim objGSS As Object
Dim objBLOB As Variant
\
Set g = GetObject(, "GeoMedia.Application")
Set objP = g.CreateService("GeoMedia.Point")

1Y72FG
N

Set objPol = g.CreateService("GeoMedia.PolygonGeometry")
With objPol
objP.X = 500000
objP.Y = 500000
objPol.Points.Add objP
objP.X = 550000
objP.Y = 500000
objPol.Points.Add objP
objP.X = 550000
objP.Y = 550000
objPol.Points.Add objP
objP.X = 500000

February 13, 2018
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objP.Y = 550000
objPol.Points.Add objP
objP.X = 500000
objP.Y = 500000
objPol.Points.Add objP
End With
Set objGSS = g.CreateService("GeoMedia.GeometryStorageService")
objGSS.GeometryToStorage objPol, objBLOB

If you run it (having GeoMedia opened) it will give error at the last line (invalid geometry object).
Previous versions worked fine.
If you replace g.CreateService with CreateObject it will work but we need to run inside GeoMedia's
environment.
Analyst Description of Problem:
Using the basic VB6 code, I created a VB.NET project on version 16.1 and duplicated the problem.
Since the customer is within the GM Application environment, they want to use the CreateService
method to avoid crossing process spaces. When you use the CreateService method, the GSS object is
of type Intergraph.GeoMedia.PClient.GeometryStorageService. When you use the CreateObject
method, the GSS object is of type Intergraph.GeoMedia.PClient.GeometryStorageServiceClass. For
me, neither way of creating the GeometryStorageService object then worked successfully on the
GeometryToStorage method call.

1XNK5
OL

SRS - Symbols Edit Point Symbol
brings up error
"Invalid Symbol
Type"

In SRS Points Symbols display error "Invalid Symbol Type" when edited in SRS File - Tab SymbolSets.
After opening the SymbolSets tab dialog and clicking on Edit the error "Invalid Symbol Type" appears
mainly for FSM-symbols.
If I click OK on the "Invalid Symbol Type" dialog 4 to 5 times the dialog comes up sometimes.

1ZU4C9
8

110A4D
FM

Selecting ‘Validate
Areas’ closes
Oracle LTT
connection used as
Cadastral
Connection
(Regression)

A customer has been using a configuration (in GeoMedia 2015) whereby they have chosen their
‘Oracle Object LTT Read-Write’ as the Cadastral Connection via the Set Cadastral Connection
command. However after upgrading to GeoMedia 2016 they now find that selecting the Validate Areas
command (from the Cadastral tab) results in the closure of the ‘Oracle Object LTT Read-Write’ in the
GeoWorkspace, thus invalidating any legend entries based on that connection.

Cadastral Validate
Areas cmd causes
Oracle LTT

Cadastral Validate Areas cmd causes Oracle LTT connection to close. This is a regression from GM
2015.

February 13, 2018

Additionally I have verified that in 16.1 if using a standard Oracle Object Model Read-Write connection
to the database and making that connection the Cadastral Connection the Oracle Object Model ReadWrite connection will remain open when Validate Areas is selected. So this appears to be a regression
in 16.1 specifically for the case where an Oracle Object LTT connection is set as the Cadastral
Connection.
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connection to
close.

Cadastral_Oracle_LTT.gws attached to CR.
1. Open Cadastral_Oracle_LTT.gws
2. Select Cadastral>Validate Areas cmd and Validate Areas dialog comes up, but there are no features
listed to validate because the Oracle LTT connection has been closed.

1TT66Z
K

GeoMedia fails to
connect to WMTS
that other clients
can use
successfully

When attempting to connect to a WMTS URL …with the GeoMedia WMTS data server the connection
fails with the message:
"Unable to connect to the database. Please verify that your warehouse-connection parameters are
correct and try again."

Other clients including Geospatial Portal and QGIS are able to successfully
connect to the same WMTS and to successfully display the tiles from the DOP
layer from the WMTS.
Multiple symbol file
(fsm) locations and
missing symbol
files

1YZSX
U0

Customer asks: "Are there any symbols for airports that are available for GeoMedia?"
The GISsym.fsm file contains the airport symbol the customer was looking for. However, it appears
that GeoMedia Desktop 2015 and 2016 (others?) are not delivering this file in the default symbol file
location (C:\Program Files (x86)\Hexagon\GeoMedia Professional\Symbols). Looks like there are other
files missing as well:
codis.fsm
geomorphologie.fsm
radio.fsm
(one or more of these may be customer supplied and not delivered with the product (support machine!))
This issue is specifically requesting that GISsym.fsm be included with the symbol files currently
delivered with GeoMedia Desktop 2016 and later, in the default symbol file location.

Contours are
incorrectly
attributed as
depressions after
running Generate
Terrain Contours.

1KOTX
DZ

[Note: This defect is reported against GeoMedia Feature Cartographer, which is part of the GeoMedia
Mapping Manager product. The complete fix is in two parts, requiring a change in GMFC as well as this
delivery of the GeoMedia Desktop.]
Contours are incorrectly attributed as depressions after running Generate Terrain Contours. Several
contours are being attributed as depressions when they should not be. 1. Open FCWorkspace.gws
and correct path to the FCElevationWarehouse.mdb warehouse.
2. Run Import Elevation Source Data using the Import cmd in GM Grid and the Prepare Elevation Data
Result Layer.mfm as input or you can use the square.tiff file.
3. Run the Apply Geomorphic Features using the Prepare Elevation Data Result Layer result from step
2. See the Apply Geomorphic Dialog and Contour Generation.png for dialog settings.
4. Run the Generate Contours cmd using the Geomorphic Feature grid layer created in Step 3.

5. Compare contour output to the Problem Depression Features.pdf to see where the problem contours
are.

February 13, 2018
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1RHRQ
XX

GeoMedia spatial
filter fails to
correctly filter if
PostGIS user has
only SELECT
privilege on table

User desires to apply SELECT only privilege to one or more tables but has found that the spatial filter
command returns an empty record set. If however the user adds INSERT a table privilege to the
group/user, then the spatial filter returns records/graphics as expected.
Customer states:

"We need to use a spatial filter for some of our datasets as they are over 25 million polygons. We don’t
really want users to have insert privileges for these tables however."

1-YVSJJZ

2015
GeoWorkspace
fails to open in
2016 (v 16.1) with
'Failed to open
document' error

Problem with
PatternedLinearSt
yle object in
custom code

A customer has a number of GeoWorkspaces that were created with GeoMedia 2015 that cannot be
opened in GeoMedia 2016 v16.1. When attempting to open the .gws file the message “Failed to open
document.” is displayed.
This problem appears to be related to the ‘Oracle Object Model LTT Read-Write’ connection and is a
regression from 16.0.

I have legacy custom commands written in vb6. One of them uses the object PatternedLinearStyle.
The following line used to work in Geomedia 2015 but now gives an error when compiled against, and
run in Geomedia 2016.
Set objStyle = CreateObject("Geomedia.PatternedLinearStyle")

1-YIJDVX
The error recieved is
Run-time error '-2147467259 (80004005)'
Automation error
Unspecified error

Pre ‘1900’
attribute values of
type ‘Date’ are
invalid in SQL
Server when AFM
enabled
(regression)

An SR was filed reporting that when using Output To Feature Classes to output a feature class from an
AFM enabled SQL Server Read-Write connection to a new SQL Server Read-Write feature class,
certain records from the source feature classed fail to be output. The error written to the GMOTTS.log
file for these failed records is like the following:
“Error: Unable to update the record. (Error: Invalid character value for cast specification.Could not insert
a record in the database.Invalid character value for cast specification.
Could not insert a record in the database. ) where ID = 1
Error: Unable to update the record. (Error: Invalid character”
Upon investigation it was discovered that the records that fail during the OTFC process are those where
the ‘Date’ attribute has a value earlier than ‘1/1/1900’ (e.g. 1/1/1899 12:00:00 AM).
To reproduce the problem, use the steps below:

1RRNGPW

February 13, 2018

1. Open the provided TestAFMGDO_2016.gws with GeoMedia 2016. This .gws contains a AFM
enabled SQL Server Read-Write connection. The ‘FtrDatesPre1900’ feature class displayed on the
legend contains an attribute of type Date with the name ’Datefield’. Each of the 7 feature instances has
a pre-1900 date value assigned for Datefield. As you can see in the displayed Data Window for the
‘FtrDatesPre1900’ feature class the Datefield value is shown as ‘Invalid DateTime Invalid DateTime’ for
each of the features.
2. Now double click on one of the red ‘FtrDatesPre1900’ features displayed in the map window to open
the Select Set Properties dialog and note that the Datefield contains a valid pre-1900 date (e.g. the
feature with ID=1 has a DateField of ‘1/1/1882 12:00:00 AM’ which is shown correctly in the Select Set
Properties dialog’.
3. Dismiss the Select Set Properties dialog and select the Output To Feature Classes command.
Choose the ‘FtrDatesPre1900’ as the Source feature to output. A default Target Feature Class with
output mode New will be defined for the same SQL Server connection, so you can click OK to begin the
output process. After the process completes an error message is displayed with the message “Unable
to create table or output all features for one or more feature classes. Refer to log file
C:\Warehouses\\GMOTTS.log for details.” The GMOTTS.log will include the errors noted previously.
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4. Next use the Warehouse Connection > Properties dialog to uncheck the ‘Enable advanced feature
model’ option. The click OK and Close on the dialogs.
5. Now if you review the Datefield values in the Data Window for the ‘FtrDatesPre1900’ feature class
you will see the correct values instead of the ‘Invalid DateTime Invalid DateTime’ text.
6. Likewise if you run Output To Feature Classes again using the same workflow from step 3, the
process will complete without error.

Properties dialog
Cannot Edit
Hypertext field
value if defined as
URL

Properties dialog:
Use of <Ctrl> key to edit a URL based hypertext value no longer works. Problem is a regression from
version 6.1
Editing of hypertext URL values has always been problematic because:
a) If you click into the field, the hypertext link/object fires instead of allowing the edit.

1M3S31
H

b) If you right-click and select Edit, the Browse for FILE dialog appears but it does NOT allow the user
to insert or edit a URL value.
Users should be able to use the <Ctrl> key when clicking into the field to edit the data value (without the
hypertext firing to the associated application). In version 6.1, the user can use the <CTRL> key but
testing in version 2015 and 2016 shows that use of the <CTRL> still fires the associated application.
The use of <Ctrl> key works in data window to edit values but fails in 2015 and 2016 Properties dialog.
The <Ctrl> key method works for version 6.1 Properties dialog.
Resolution: The help topic has been altered to indicate how editing is done by clicking within the cell but
away from the URL text (after, before, above, or below it) when the cursor is not changed to indicate
hyperlink invocation.

1M8ALZ
1

Layout Insert Scale
Bar dialog default
Unit Label does not
match the default
Unit (Regression)

Layout > Insert Scale Bar dialog default unit does not match the default Unit Label. Problem is present
in 2015 and 2016 but is a regression from version 2014.
Example:
The default Unit is shown as "km", yet at the same time, the default Unit Label shows "Miles"; it is
expected that the default Unit and Unit Label should be of equivalent units of measure.

1M1BN
5A

Query Connectivity
should not require
a read write
connection
(Regression)

1XJVP0
X

Major performance
degradation
utilizing GM 16.0
as compared to
GM 15.0

1TPHA
CS

Open/closing
Queries dialog
causes memory to

February 13, 2018

Query Connectivity command (previously called Validate Connectivity in version 6.1) is unavailable
(command is grayed out) if all connections are read-only. A read-write connection should NOT be
required to generate a connectivity query.

Internally, while testing, we have workspace that is loaded both on a GM 16 and a GM 15 machine.
When attempting to open the Queries command, it takes GM 3 minutes, 35 seconds to open the dialog
on a GM 16.00.0000.10267 machine and it takes the Queries command only 4 seconds to open the
Queries dialog on the machine running GM 15.00.0000.10203, over a 50 fold drop in performance.
Once the dialog is up, if any changes are made to a query, a similar performance hit is being seen
when the changes are being executed, all Queries operations are terribly slow with GM 16.

Open/closing Queries dialog causes memory to increase every time.
Using customer's dataset if the Analysis>Queries dialog is opened, but no action taken and then closes
the Queries dialog the CPU memory on the machine increases approximately 150,000 K. This happens
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1VJT8C
7

increase every
time.

every time the Queries dialog is opened and closed even without doing any action on the Queries
dialog. Once the Queries dialog is opened the user clicks on the Close button.

Undesired X and Y
shift when
transforming
between
NAD83.NAV88 and
WGS84.EGM96

User has reported and provided example data that shows an unexpected X and Y shift when
transforming between NAD83/NAVD88 and WGS845/EGM96. The problem occurs when NGSGEOID
.bin files have been loaded and configured for proper Z height transformations.
1. Place GEOID files and area.ini in C:\Program Files (x86)\Common Files\Intergraph\Coordinate
Systems\3.0\Config\NGSGEOID folder.
2. Create New GeoWorkSpace and establish connection to Test_Sanborn_Points.mdb.
3. Add the two Point features to the map.
Observation: Notice how the points do NOT align. It is expected that these points should be at or near
coincident. Problem does not occur if the binary NGSGEOID files are not used however then the Z
height values are not properly transformed.

1JJGD4
7

Labeling>
Expression Builder:
Some informational
strings are English.
Need to be
localizable.

i18n: Labeling> Expression Builder: Some informational strings are English. Need to be localizable.

Static Label text
geometry fails to
transform with
coordinate system
changes

Static label text added to the map legend fails to transform if the GeoWorkSpace Coordinate System is
changed. If however, the same label text is added to the map using Legend > Add Legend Entries
command, the text geometry transforms as expected with changes to the GeoWorkSpace Coordinate
System.
Steps using example data:
1. Open GeoWorkSpace correcting path to .mdb warehouses as needed.
2. Save the .gws file.

1U66Z0
O

3. Use Labeling > Display Labels to display STATE_NAMES from the Static_Labels warehouse
connection.
4. Change the coordinate system (for example to Geographic)
Observation: The labels are NOT properly transformed at all and data is totally misaligned.
5. Exit without saving.
6. Open .gws file again.
7. Use Home tab, Legends > Add Legend Entries to add Static_Labels_txt feature to the map.
8. Change the coordinate system.
Observation: The labels ARE transformed as expected.

February 13, 2018

51

Issues Resolved

1YSZJ6
B

Silent Install of
German Language
Pack fails using
instructions from
GeoMedia_Installat
ion_Guide.pdf

When the German Language Pack for 16.1 (v16.00.0000.10023) is installed in Silent Mode using the
command line “setup.exe /s GermanGM /ni ACCEPT_EULA=1” the installation will complete without
any obvious errors.
In fact after the setup.exe completes if you check the Control Panel > Programs and Features you will
see an entry for ‘Hexagon GeoMedia Desktop 2016 German Language Pack’ indicating that it was
installed successfully.
However after running the configure command line of “setup.exe /s GeoMedia /c GeoMedia” (with the
appropriate edit to the Intergraph.GeoMedia.ConfigurationWizard.exe.config to modify the
RuntimeLCID value to 7 for German) the configuration does not change to German. In other words
when you start GeoMedia the user interface is still shown in English, despite installation of the German
language pack and configuration to German from the command line.

GeoMedia
Essentials - Error
Unique Value
Thematic

When the client wants to classify the shapefile by using the option 'Unique Value Thematic' and they do
not use the option Classify, but want to generate own values, they receive the following error code:
GMLgdCtlObject variable or With block variable not set. I tested this on GM Essentials and GM
Professional. GM Professional gives no error, but you can only fill in numerical values. GM Essentials
gives the error all the time.

Pictometry and
Bing Maps fail to
work in GeoMedia
SP3 (Build 10290)
Regression

Customer with pictometry data has noted that the Manage Data, External Maps commands no longer
work in Geomedia Desktop 2016 SP3 (Build 10290). The buttons for Manage tab, Bing Maps and
Pictometry are grayed out and cannot be accessed. There does not appear to be a work-around.

00020
653

Cannot enter
thematic Unique
Value classes
manually

When the client wants to classify the shapefile by using the option 'Unique Value Themic' and they do
not use the option Classify, but want to generate own values, they receive the following error code:
GMLgdCtlObject variable or With block variable not set.

00020
728

Ghost circles or
arcs displayed in
map view
depending on
display scale
(Regression)

User has area geometry feature class where the geometry contains many composite polyline
geometries with arcs. Many have holes. Displaying this data, you will see what appear to be circles or
arcs (ghost type elements) in the map display. The number of ghost elements will vary according the
display scale where zooming out (Smaller Display Scale), you will see more and zooming in you will
see fewer of the problematic elements. Problem is a regression from version 2015 (tested build 10258).
Problem observed in version 16.1 and 16.2.

00020
746

Geomedia .gws
crashes when
deleting legend
entry subtitle

If a user removes a subtitle from a legend entry, and then clicks on the legend entry name in question
after backspacing all characters, the GM .gws will crash.

Dialog hangs
GeoMedia after
using context
sensitive Help or
switching to
another application

When running on a Windows 10 operating system, after using F1 to get the context Help for ‘Map
Window Properties’ and closing the Help Window with the Cancel (X) button, GeoMedia hangs forcing
the GeoMedia process to be killed via Task Manager.

00020
653

00020
624

00020
778

Issue is a regression from GeoMedia 16.1 (build 10267).

Using GM 2016 build 10290

The steps to reproduce the problem are as follows:
1. Start GeoMedia and open any GeoWorkspace (e.g. USSampleData.gws) or create a new
GeoWorkspace.

February 13, 2018
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2. Right-click in the Map Window and choose ‘Map Window Properties’ from the context menu or
choose Map Window Properties from the Home tab of the ribbon bar.
3. Press F1 to enable the context Help for the ‘Map Window Properties’ command.
4. Close the GeoMedia Help dialog for Map Window Properties by clicking the (X) button in the title bar.
Observations:
After dismissing the Help dialog, note that the ‘Map Window Properties’ dialog is no longer visible.
This will result in GeoMedia hanging, so that Task Manager must be used to kill the process.

00013
164

Displaying a single
legend thematic
legend entry
doesn't display the
theme in the Map
Window

Displaying a single legend thematic legend entry doesn't display the theme in the Map Window
To reproduce:
Start USSampleData.gws. Select the thematic legend “Rivers” in the active legend. Right click and
select Display Off.
Select “Perennial – Single Line” in the thematic legend entry “Rivers” and right click Display On.
In the legend “Perennial – Single Line” is now set to Display On, but this legend entry is not displayed in
the Map Window.

00020
749

00020
569

1JMEI2
8

00020
713

Crash occurs in
GeoMedia 16.1
with Select Set
Properties when
AFM is Enabled for
SQL Server
(Regression)

Temporal Query
problem with dates
when regional
Short date = ddMMM-yy

German Language
Pack "Invalid linear
pattern with name:
Volllinie."Error in
layout window"

When AFM is enabled for a SQL Server connection a crash occurs after
performing several zooms and pans, then double-clicking a feature to display
Select Set Properties. This problem does not seem to occur with 16.0, so this
seems to be a regression from that version.

The Queries command displays the ‘As of date’ from a Temporal Query with the
day and month swapped if the ‘Short date’ setting for the PC is ‘dd-MMM-yy’ and
the day value (i.e. dd) falls between 1 and 12. For instance when those two
conditions are met a Temporal Query that was created with the ‘As of date’ = ‘11Apr-17’ will be displayed via the Queries command with the ‘As of date’ = ‘04-Nov17’.
German Language Pack "Invalid linear pattern with name: Volllinie."Error in layout window"
A problem with the GeoMedia Desktop SP1 German Language Pack produces an error when right
clicking on a map/picture in the layout window and selecting the properties. The error message reads:
"Invalid linear pattern with name: Volllinie."

This mainly caused due to the fact that the style names in the tab general (right
click on map in layout window > properties) stay in English.
Delete of multiple
point features from
Access connection

February 13, 2018

A customer has an Access warehouse containing a point feature class that has a primary key
consisting of two attributes (MOFILE which is of type Text and CHAINAGE which is of type Long
Integer). When the point feature class is added to the legend and the user selects and then deletes 50
to 100 of the point features the legend entry is set to a disabled state (so that the legend entry icon is
shown with the diamond containing a red exclamation point and there are no features displayed in the
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invalidates the
legend entry

map window). If you right click on the legend entry and select Load Data the remaining point features
are re-displayed in the map window and the legend entry returns to a valid state. If you only delete a
few of the points at one time (fewer than 20 for instance) the legend remains in a valid state and is
updated as expected with the new legend statistics reflecting the deleted points.
This issue seems to be related to the primary key definition, since if you use Output To Feature Classes
to generate a new feature class with a new primary key (e.g. ID1 of type AutoNumber) deletes of
multiple features from that feature class can be performed without any type of error.
Additional observations:
Validate Geometry reports no anomalies for the COE_STN_RR feature class.
Turning off the ‘Undo’ option does not change the behavior.

00020
725

Update Attributes
throws Object is
invalid for operation
error when input
record set has
multiple keys

When using Update Attributes command to update features with multiple primary keys, the following
error may occur when the "Enable undo and logging" option is enabled (checked):
GeoMedia Desktop
Object is invalid for operation.
OK
The error occurs multiple times upon completion of the update to the point that the user may need to
use the option to get rid of the repeating message, after which the recordset is unloaded by the
application. The input record set is left in an unloaded state however once re-loaded the user should
find all attributes have been correctly updated. The user can forcefully reload the record set using a
right-click on the legend entry for Load Data or Refresh of the Warehouse Connection.

ISSUES RESOLVED (GEOMEDIA 16.5)
CR #

1FFI1K
1

SUMMARY

Description / How to Reproduce

Problem importing
GTech legend and
then saving .gws
on German
machine with
German GM
configured

Issue/error occurs when saving workspace because imported GTech legends Style Properties with
advanced tab attribute based expressions. The problem is in the style rules list separator "In (...)"
function which should be a semi-colon ";" but is a comma ",".
German machine configuration. Still get error when saving with Style properties “Character string”.
Windows 2012 R2 Standard German, GeoMedia 2015 SP1 German Language Pack
Regional and language setting: Format German (Germany), Location Germany, Administrative>System locale German(Germany)
Does not occur on English machine configuration.
Same machine Windows 2012 R2 Standard German, GeoMedia 2015 SP1 German Language Pack
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Regional and language setting: Format English (United States), Location United States, Administrative>System locale English(United States)
In the style properties dialog if the list separator "In (...)" function expression is changed from “,” to “;”the
error will not occur and the .gws can be saved without an error

00021
133

GWS opening time
- regression

Unable to connect
to MS SQL Library
(Regression from
16.1)

The performance of loading Dynamic Segmentation queries has dropped significantly in version 16.2 as
compared to version 16.1. The time required to load is so slow that the command is essentially
unusable. The problem reported using Oracle data however the issue persist when using Access data.
This represents a regression from 16.1 and would prevent users who use Dynamic Segmentation from
upgrading to 16.2.

When attempt to connect to GeoMedia Library stored in MS SQL the following error occurs:
*******
GeoMedia Desktop

00021
255

Unable to create library database objects. Standard metadata tables may be missing.
*******
This is regression from GeoMedia Desktop 16.1. Error in 16.2 prevents use of MS SQL Libraries and
occurs despite connecting using the same user credentials as used in the successful 16.1 connection.

11060N
SY

GSB grid file
calculation
incorrect

19BGB
SD

Button labels on
German 'Export to
GML' dialog
misspelled (i.e.
Durchuchen
instead of
Durchsuchen)

153ENV
Q

Publish to Map
command outputs
areas with holes to
KML incorrectly

A G/Technology customer is using a grid file that is very large and dense. According to CCS there is an
index calculation using variables that are too small and thus overflow.

A SR was filed noting that there is a typo in the German GUI for the Export to GML dialog. Specifically
the Browse buttons for the GML schema file and the Base GML Schema are labeled as 'Durchuchen'
instead of the correct spelling of 'Durchsuchen'. The Browse button for the GML data file on the same
dialog has the correct label of ‘Durchsuchen’ already.

The 'Publish to Map' command publishes an area with holes to KML as MultiGeometry (so that each
hole becomes a polygon with an outerBoundary). The expected result is for the main polygon to have
an outerBoundary with the each hole represented as an innerBoundary.
This problem can be observed by serving a KML file that contains an area with holes into GeoMedia
then publishing that feature to a new KML file and serving the new KML file into GeoMedia as well.
This difference in the geometry also affects the display of the KML file in Google Earth.

1ML83P
S

Icons too small and
dialogs partially
displayed on
Microsoft Surface
Pro 4 running
Windows 10

Customer has found that the icons within GeoMedia command dialogs are too small when GeoMedia
2016 is installed on Microsoft Surface Pro 4 tablet running Windows 10.
Specific examples cited by the customer are the GPS Tracking command where the command icons on
the dialog for Settings, ‘Stop tracking’, ‘Turn on skyplot’, etc are approximately a quarter of their normal
size and the Tracking dialog itself appears to be only partially displayed.
A second example cited by the customer is the Add Legend Entries command. It appears that the
customer is concerned about the size of the icons to the right of the checkboxes that indicate the object
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type. For instance there is a “?” mark symbol to the right of the Queries checkboxes and a geometry
type icon (for Areas, Point, Lines, Text, etc.) to the right of feature classes to indicate their type.

1D0AR
TU

Customer has
3200X1800 display
- reports toolbars,
dockable controls,
WMS text unusable

On a full resolution 3200X1800 display, the customer complains that:
1) The dockable control for spatial filter is unusable.
2) The WMS service -> legend entries are too small.
Not corrected by changing resolution to 1600X900.

1LQH5
RZ

The message
displayed on
Labeling is partially
English but the
string has been
localized.

i18n: The message displayed on Labeling is partially English but the string has been localized.
Labeling > Preferences
When the specified folder is not vaild, then the message is displayed. (See attached image)

The corresponding strings has been translated but not used in this message box.

Spatial Model
Editor ‘Oracle
Features Proxy’
fails (Feature
accessor error)

When attempting to make an Oracle Features Proxy connection to an Oracle database an error
message is displayed with the text…
“Feature accessor is not on a row.”
Since the ‘Database Connection’ row cannot be selected on the Connection Manager dialog without
error, the ‘Features Tables’ grid is never populated thereby preventing selection of a desired ‘Features
Table’ row and creation of the .ofp file.

1YG822
N

This problem was reproduced on four different machines using GeoMedia Desktop version
16.00.0000.10267. However the same workflow is successful when using version 16.00.0000.01415 so
this is a regression from the previous release.
Additional Observations: It is possible to successfully create a SQL Server Feature Proxy (*.sfp) file
using the same workflow, so the problem seems to related to the Oracle connection rather than the grid
control.

1YG3B
W6

Spatial Model
Editor ‘Oracle
Features Proxy’
creation fails for
Read-Only Oracle
user

When attempting to make an Oracle Features Proxy connection to an Oracle database via a ‘ReadOnly’ Oracle user an error message is displayed with a message like the following…
“Custom type mapping for 'dataSource='TSDB64' schemaName='MDSYS'
typeName='MBRCOORDLIST'' is not specified or is invalid”
The values in the error message for dataSource, schemaName, and typeName will reflect the particular
Oracle database to which you are attempting to connect.

1UDPB
Y5

Spatial Modeler
‘Preview’ operator
fails with errors if
input feature uses
EPSG:2056
coordinate system

February 13, 2018

When a spatial model is created where the input features to the Preview operator have the EPSG:2056
coordinate system assigned an error will occur when the Preview button is invoked for the model within
the Spatial Model Editor utility delivered with GeoMedia 16.00.0000.1405. There are actually two error
messages displayed in succession. The first error message states “No translation for spheroid/datum”.
When the OK button is used to dismiss the first message, a second message is displayed stating
“Failed to open Preview layer.: : Unsupported moniker”. When these errors occur, there are no
features displayed in the resulting Preview window.
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If you add a ‘Coordinate Transformation’ operator prior to the ‘Preview’ and set the TargetCRS for the
CoordinateReferenceID port to “Authority: EPSG; Code: 32632” for instance, the Preview will then
complete successfully without error messages and display features in the preview window. However if
you double-click the ‘Coordinate Transformation’ operator to review to open the Properties dialog for
that operator you will then see the same “No translation for spheroid/datum” that was previously
displayed for the Preview operator. If you click OK to dismiss the first message a second message
stating “Unsupported moniker” is displayed. The customer notes that the Preview works if the same
spatial model is run in IMAGINE.

Spatial Modeler
crashes when
choosing a Swiss
Coordinate System

Reproduction:
1) Open Spatial Modeler
2) Insert Coordinate Transformation
3) Double Click on TargetCRS

1TCP6F
O

4) Click on "Set"
5) Change to Standard
6) Categories: Switzerland
7) Ok to the Error message
8) Click on CH1903*/LV95 (EPSG 2056), Oblique Mercator for SOCET SET, or Swiss LV03(EPSG
21781) results in Direct Crash
9) Click on Oblique Mercator (Bessel) or ch1903 --> Crash after confirmation.

1TY55Q
J

1VEFB
E3

1L1FH3
2
00021
356

Security
vulnerability with
xerces-c_2_8.dll Version 2.8.0
delivered with
Spatial Modeler

The software installs Xerces 2.8.0. Please be advised that Xerces 2.8.0 and all earlier releases are
100% unsupported and should no longer be used by applications.

Removal of
ERDAS IMAGINE
2016 renders
GeoMedia Desktop
2016 corrupt

Customer reports and support duplicates a problem with removal of ERDAS IMAGINE 2016 from
system with GeoMedia Desktop 2016. GeoMedia is left inoperable. Running GeoMedia Desktop 2016
repair restores functionality.

Spatial Intersection
is returning
incorrect results for
query between two
area feature
classes

The current version is Xerces 3.1.4.

Problem appears to be related to the Spatial Modeler installation? After removing IMAGINE, the Spatial
Modeler installed by GeoMedia Desktop is missing several files.
Spatial Intersection is returning invalid results (i.e. an incorrect geometry with zingers) for a query
between two area feature classes when using the ‘overlap’ or ‘touch’ operator. Validate Geometry does
not indicate that there are any geometry errors that would account for the error in the results, but the
geometry is unusual in that it appears that all of the vertices are rounded to whole numbers (as if they
were integer).

Contour generation Spatial model fails on GeoMedia Desktop 16.2 but works perfectly on IMAGINE.
Contour generation
model fails from the
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Run Spatial Model
command

00022
045

Cannot create
more than one gws
from a read-only
template

00022
149

Drawing Toolbar is
partially displayed
on High DPI
monitor preventing
access to multiple
commands

00022
182

Spatial Model
Editor does not run
with borrowed
license

1WFVZ
G2

The certificate of
the digital signature
of version 2016 GM
Desktop, Setup.exe
is expired

When a gwt template file has a read-only flag set, a new gws based on this template can only be
created once. Each successive attempt to open this template will result in an error. This is most likely
caused by the fact, that a copy of the gwt file is created in the %TEMP% folder and is not deleted upon
GM exit when the template file is read only. This worked fine in GM 2015.

When running GeoMedia on a High DPI display device the Drawing toolbar in the layout window is
clipped both vertically and horizontally, so that it is only partially visible. The horizontal clipping results
in the loss of a number of commands on the right side of the toolbar making them inaccessible. Thus
far, no workaround has been identified for this issue.

If a user borrows a GeoMedia Desktop license it is expected that the user can also run either a Spatial
Model (spatial model engine) or Spatial Model Editor (GeoMedia Professional tier only). This is not the
case however as Spatial Modeler will NOT start after a GeoMedia Professional license has been
successfully borrowed. The Spatial Model Editor utility for example will continue to look for the license
server when offline even when GeoMedia Professional will run offline (in a borrowed state).

The certificate of the digital signature of version 2016 GM Desktop, Setup.exe is expired. Here are the
steps to reproduce the problem. Once you download GeoMedia Objects 2016:
•

unzip

•

click to get the file properties of Setup.exe

•

go to the Digital signature tab and click Details

•

click on view the certificate

The certificate is valid until May 14th 2016.

00022897

00022
767
00020
667

00023
104

Picklists defined for
a PostGIS ReadWrite connection
are not displayed in
the product

Non-loaded legend
entries show record
number (0)

Legend Statistics
Count Properties
show zero records

February 13, 2018

When using a PostGIS Read-Write connection the Select Set Properties command fails to display the
picklist values for an attribute field for which a valid picklist has been defined.

Starting with GM 2016, the non-loaded legend entries show the record number. They used to show no
number until loaded in 2015 and before.

2016 Legend Statistics Count Properties show zero records while in prior versions zero count was not
displayed if
A bug in the map window legend properties count has been introduced with GeoMedia 2016. (at least in
V2)
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Previous versions legend entries that were not loaded did not display any information on how many
features are loaded from the database. Now these legend entries shows (0), as if they were loaded and
in fact has zero features in the record set. This causes confusion.

00020
764

1-4VHJJB

00014
324

1-K7G7IU

00006
913
1-E3E83J
00018102
00014780

'Unhandled
Exception' error
occurs when
reviewing Rules
properties with
German regional
settings

Select Set
Properties grid not
remembering
column widths
(minor regression
from version 6.0)

Moving Labels
created by Label
Manager

Toggle Dynamic
results in error
Unable to get
GDatabase
property

When using German regional settings, an ‘Unhandled Exception’ error occurs with Label Manager,
upon click of the Rules button to review the properties of a previously created rule where the ‘Allow Use
of Leader Lines’ option was enabled with the Leader Line Width set to 0,1. This problem does not occur
with English regional settings.

Client has just completed a roll-out from 6.0 to 6.1 and has noticed that in 6.1 the columns widths of the
Select Set dialog grid are not being saved after the dialog has closed, whereas they were in 6.0. The
dialog dimensions however are being saved. A lot of their tables have long field names, so they are
having to resize the column on a regular basis.
In the Feature Attribute Form the attributes of the Feature are displayed in two columns, one for the
name and other for the value. If you try to change the width of the columns, it is impossible if you don't
select previously one value (one row).
After using the Edit Geometry command to move the position of a label created with the Generate
Static Labels command a Zoom or Fit was required to refresh the screen in order to see the correct
display of the moved label. Upon researching the issue it was determined that the labels were
generated with the Output set to GeoWorkspace, so the labels being edited are from a query.

Users are reporting that when attempting to select the Labeling, Toggle Dynamic option, the following
error occurs:
Unable to get the GDatabase property if the connection was never opened. Please connect and try
again.

00009619

Failed to dynamically label the map.

00006075

At this point the user cannot display dynamic labels. If the user can successfully remove all invalid
queries (those that do not show an icon after reviewing within Analysis > Queries > Properties) AND
remove all invalid connections, then it may be possible to once again display labels. The Display Labels
command appears to be unable to gracefully handle certain invalid references. Need better handling of
closed connections to avoid this problem.

00005116
00018899
00013065
00009679
00009320
00009973
00003841
00021140
00022669
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Add Legend
Entries (from
Legend right-click
menu) incorrectly
loads legend
entries that are set
to ‘Display Off’

00021
166

When the ‘Add Legend Entries’ command is invoked from the Legend right click-menu and a new
legend entry is added, the data for any existing legend entries that were set to Display Off (that were in
an unloaded state because the ‘Do not load data when opening GeoWorkspace’ option was enabled on
the General tab of the Options dialog when the GeoWorkspace was opened) will be loaded.
This behavior occurs only if the right-click menu from the Legend was used to select the Add Legend
Entries command. The existing legend entries that are in a Display Off state remain unloaded if the new
legend entry is added using other methods including…
•

The Home > Legends > Add Legend Entries command from the ribbon bar

•

The ‘Add to Map Window’ right click option from the Explorer command

•

The Home > Legends > Add Thematics Legend Entry

‘Insert Feature’ automatically adding the legend entry after digitizing a new feature
instance for a feature class not currently on the legend

00021
719

Installation of
GeoMedia 16.0 or
16.1 on Windows
Server 2012 R2
results in
SideBySide errors

When GeoMedia Desktop 16.00.0000.01405 or 16.00.0000.10267 is installed on new Windows Server
2012 R2 operating system where no GeoMedia software has been previously installed there will be
multiple entries written to the Event Viewer (Windows > Application) log reporting SideBySide errors.
The SideBySide errors occur during the installation (rather than when running the product) and the
errors all seem to be associated with the various Intergraph.CoordSystem components (e.g.
Intergraph.CoordSystems.IgdsUtil, Intergraph.CoordSystems.Cgnl, Intergraph.CoordSystems.Services.
and Intergraph.CoordSystems.MiniPSupt).
The errors are reported for each of the executables delivered with GeoMedia (i.e. GeoMedia.exe and
the executables for the various utilities such as CCSDefCSF.exe, SchemaRemodeler.exe, etc.).

00021
722

Database Utilities –
Coordinate System
creation fails on
German system for
Oracle connection
with ORA-01722
error

Database Utilities – Coordinate System creation fails on German system for Oracle connection with
ORA-01722 error.

Label Manager
settings and
resulting Dynamic
labels overlap

Label Manager settings and resulting Dynamic labels overlap. Workflow to reproduce:

On a machine with a German operating system (e.g. running Windows 7 Professional German) install
GeoMedia Desktop 16.00.0000.20059. The customer reported this problem with the German Language
Pack installed, but I was able to reproduce the error without the language pack.

1. Create a new blank gws or open CR 1-9CQ4FV.gws
2. Connect to the USSampleData (Access) warehouse

19CQ4F
V

3. Display only the feature class 'Cities'
4. Run Label Manager and create a label on the Cities legend entry containing the ID and the
CITY_NAME (Expression : ID && CITY_NAME).
5. Add a symbol to this label with the 'Scale to text' option activated.
6. Create a rule for this label with just create leader lines selected.
7. Display the labels using Toggle dynamic.
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8. The result is OK (no overlap).
9. Modify the label properties by splitting the labels on 2 separated lines (Expression :
ID\nCITY_NAME).
10. The resulting Labels display overlapped labels.
This bug appears when the following conditions are active :

Output to Feature
Classes to Oracle
fails to add legend
entry when spatial
filter is applied

•

A multiline label

•

A symbol on the label

•

Leader lines activated

Oracle users using spatial filtering with features created by Output to Features Classes command will
encounter errors when attempting to add features to the map legend.
1. Apply spatial filter
2. Use GeoMedia 2016 Output to Feature Classes to copy features from Access to Oracle.
Observe following message:

Error creating a legend entry for OM_ALABAMA.STUDY_AREA
Source: GeoMedia
Description:The input recordset is invalid.

00022
046

Continue with operation?

Selecting More option on the error dialog displays the following message:

ORA-00904: "A"."GEOMETRY"."SPATIALEXTENT": invalid identifier
An error occurred in the underlying database

The "error occured in the underlying database" occurs once for every record.
Spatially indexing the data seems to correct the problem so the errors can be avoided when using
spatial filtering.

00022
161

Split by Existing
Features can hang
or crash GeoMedia

February 13, 2018

User has reported problem where GeoMedia Professional hangs or crashes when using the Split
command with the Split by Existing Features option. Issue can prevent user from saving any changes
to the GeoWorkSpace (.gws) document. Problem is a regression from behavior observed in 2014 and
2015.
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In the data provided the goal is to split the large area (hydroarea) using the boundary line (hydroline)
with the Split by Existing Features option.
General Workflow (see also Attachments for data and example video)
1. Select the HydroArea.
2. Select the Split by Existing Features option.
3. Select the HydroLine
4. Double-Click to perform the split.
Observation: The application hangs with continual on screen wait cursor. No CPU activity for
GeoMedia.exe. Split by line works even when splitting along the entire length of the linear feature
(HydroLine).

00022
491

18XQG
DP

ExportToGMLServi
ce does not escape
special characters

Break all feature
classes not
honored against
categories

When exporting to GML, labels of text geometries containing special characters such as < or >, are
exported as is, thus not escaped correctly. It results in an invalid GML file.

What is happening is that when collecting features (whether it’s a point, line or area feature) a node is
not being placed on the feature that is being intersected. The results are that the feature being collected
contains the vertex at the point of intersection of the underlying feature, but the underlying feature does
not have the vertex. The 'break all feature classes' option is active for Placement and Editing.
After conducting several tests we found that this only happens if all of the following conditions exist:
•

The GeoWorkspace contains more than one warehouse connection where at least one of the
connections is closed

When selecting the a feature to be inserted, the feature is selected from a previously created Category

00022
469

In DefCSF, a userdefined name is
always overwritten
with EPSG Code

User has Coordinate System (.csf) files created with user defined names (as seen on the dialog after
opening in the Name property field). If we open these coordinate systems in 16.2 the name is
immediately over-written with a string representing the EPSG code in the form of: EPSGnnnn
Problem is a regression from version 16.0 build 1415 (16.0 patch 1). Problem began in 16.1, build
10267.
We expected that the user defined Name property would preserved and not be over-written as it is not
null.

00022
846

Database Utilities GDOSYS Oracle
GFEATURES-View
is not being created

Database Utilities doesn’t work correct for GDOSYS creation and metadata table creation on Oracle on
Germany Operating systems.
GDOSYS is created by using Database Utilities. But the view GFEATURES is not created and missing
afterwards in the GDOSYS Metadata Schema. Same behavior with script CreateGDOSYS.sql
Running the database utilities a second time GFEATURES was created. But not running the Script a
time. And it seems to depend on German operating system.

00021
879

Layout Print or Plot
to PDF of WMTS

February 13, 2018

Users may experience problems when printing or plotting WMTS data to PDF using GeoMedia Layout
Window, File Print command. When printing a large sheet (A0, A1, A2, A3 sizes for example), the
output PDF may be blank, incomplete (partial), corrupted or not created at all. It is believed that
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data fails for large
sheets

00021
543

1KPQC
X4

Table's owner
unable to secure
table in GTM in 12c
R2

WFS connection
with
Username/Passwor
d fails when .gws is
reopened even
though password is
provided

00021
607

WFS attribute
queries on values
containing umlaut
characters fail to
return expected
results

00022
446

Delete of Rule
Classes results in
automation error
and crash of
GeoMedia

GML connection
error 'out of stack
space' in
GeoMedia Pro

1619NS
D

GeoMedia may be submitting unnecessary WMTS layers to print rather than only the appropriate tile
layer for plot scale.
GeoMedia documentation fails to indicate that for Oracle 12c, a normal DBA cannot write to
MDSYS.SDO_GEOM_METADATA_TABLE unless explicitly granted the right.

When a GeoWorkspace with a WFS connection that requires a Username/Password is saved and then
that GeoWorkspace is reopened it is not possible to open the existing WFS connection even though the
appropriate password for the WFS is provided on the Advanced Options dialog. The error displayed to
the user is the generic “Version negotiation failed. The WFS does not support the version supported by
the data server (2.0.0/1.1.0/1.0.0/0.0.14/0.0.13).”
This problem occurs when the default StorePassword value of 0 is used for the WFS data server. If the
StorePassword value is set to 1 then there is no need to reenter the password for the WFS when the
GeoWorkspace is reopened, thus the problem does not occur. Setting the StorePassword value to 1 is
not an option for customers working in a secure environment however.
It seems that attribute queries on text fields containing values with umlaut characters fail to return the
correct and expected result.

When using an AFM model enabled connection, if attempt to delete rule classes from the Feature
model, then GeoMedia Professional application will crash. Problem does not occur in 16.00.000, build
1415 (problem is specific to 16.1 (build 10267+).

A GML connection with a lot of xsd files (including gml3.1.1 and citygml) an error when making the
connnection in GeoMedia Professional. There are two errors that showed up
- 'Out of stack space'
- 'Out of memory'
There is very few data in the GML, but the structure is complex. Every feature is composed of an area,
all points of the area and some attributes.
It looks like that GeoMedia cannot handle the structure of the GML and corresponding xsd files.
Customer claims that the gml and xsd's are valid with OGC.

18VBY7
F

GeoMedia fails to
connect/display
layer from WFS
URL that works
with Geospatial
Portal 2013

February 13, 2018

I have tried to connect this service in GeoMedia Professional 13. The service is not connected, it return
an error. This service was developed by the customer with other software. I can't say that the service
was 100% correct, but I have checked the service in Geospatial Portal 13 and it can be connected
without any error and display data.
URL service http://www.ign.es/wfs-inspire/ngbe
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The GetCapabilities URL is http://www.ign.es/wfsinspire/ngbe?Request=GetCapabilities&Service=WFS.
I've verified that GeoSpatial Portal 2013 can connect to this URL and successfully display features in
the map view for the NamedPlace layer.

00020
964

A GML data
connection only
shows one feature
(terrain), others
exist but the legend
only shows terrain
feature

00022
783

GML data server
fails to connect to
GML file with
“Access is denied.”
Message

00008
010

Customer believes
WFS filter request
should not return
an error when GET
fails, but POST
succeeds

A GML data connection only shows one feature (terrain) Other's exist but the legend only shows terrain
feature.
After making a GML warehouse connection to "TOP10NL_02O.gml" only one feature(relief/terrain)
displays in the map window. The other features do not display even though records are available for
them. These layers can be seen if the "TOP10NL_02O.gml" is displayed using QGIS viewer.

A customer provided a sample GML file from the Dutch Kadaster in the Netherlands named
‘kadastralekaartv3_kadastralegrens.gml’ that can be opened successfully using QGIS. However when
attempting to server the GML file with the GeoMedia GML data server the connection fails with the
familiar ‘Unable to connect to the database’ message and the More button reveals the additional
message “Access is denied.”.

An SR was filed by a customer noting that they have a WFS that prohibits filtered GET requests (either
spatial or attribute filters), but the WFS will accept POST filter requests.
Using this WFS the customer has noticed (via the use of Fiddler and the GDOWFS.log file) that when
they submit a filter request via the Attribute Query command or by applying a Spatial Filter that the GET
request fails because the service returns a HTML page with a “error 403 Forbidden” message. However
the WFS data server then submits a POST request with the same filter information and the service will
accept the POST request. However no results from the POST request are returned to the user in
GeoMedia. Thus the customer states…

“GM should not stop working when receiving a html page but should continue with processing the
requests it creates after receiving the error html page.”

Connection fails
when URL contains
a ';’ character, but
other clients can
connect
successfully

00020
254

00018
063

WFS services with
https configured
cannot be

February 13, 2018

The OGC services offered by Land Information New Zealand (LINZ), a government agency, require an
API key for access. That API key is included within the URL in the format shown below… When
attempting to connect to this WFS URL from GeoMedia with the WFS Read-Only data server the
connection fails with the ubiquitous message 'Version negotiation failed. The WFS does not support the
version supported by the data server (2.0.0/1.1.0/1.0.0/0.0.14/0.0.13).'. Using the Fiddler Web
Debugger utility you can see that the URL submitted via GeoMedia for the WFS data server connection
was actually… https://data.linz.govt.nz/services?request=GetCapabilities&SERVICE=WFS As you can
see the URL was truncated at the position of the semi-colon “;” character, so that it is no longer a valid
URL for accessing the customer WFS. The WFS data server automatically adds the
request=GetCapabilities&SERVICE=WFS parameters to the URL which accounts for the complete URL
shown in Fiddler. However if the URL is modified to encode the “;” character so that it appears as…
https://data.linz.govt.nz/services%3Bkey=d011d2eda3b649fc8af142e308046611/wfs/layer772?service=WFS&request=GetCapabilities … this URL can be used to connect to the WFS
successfully using the GeoMedia WFS Read-Only data server. The only difference in the URL for the
successful connection is that the semi-colon ( was replaced with the %3B characters. The semi-colon
character is a reserved ‘delimiter’ character for a URL and it appears that its usage in the URL in this
context is valid. Therefore it seems that the WFS data server as well as the other GeoMedia OGC data
servers should be able accept the presence of the semi-colon character in the URL by either parsing it
“as is” or encoding it if necessary.
We are installing 2015 products on the client’s server. We create several WFS services. We follow the
instruction in the web.config to enable https protocol. The WFS services are consumed fine in
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consumed in
GeoMedia 2015

Data server adds
attributes that
cause failure when
using Output To
Feature Classes

00022705

00018
303

00021
292

Example for
Functional
REPLACE function
links to incorrect
webpage

00013
855

ProgID for SQL
Server Native
Spatial RW data
server is not listed

Geospatial Portal instances, but they cannot be consumed by GeoMedia, showing the error below:
”Schema declaration for namespace 'http: //www.intergraph.com/geomedia/gml' is not found.”
When the WFS data server in GeoMedia is used to connect to the customer provided WFS at…
https://data.canterburymaps.govt.nz/services%3Bkey%3D2452782855cd4b9bb7ad10c65876bc99/wfs/l
ayer-7494?service=WFS&request=GetCapabilities … if you review the attributes associated with the
Clean_Air_Zones feature class (via Feature Class Definition) you will see that there are five attributes
listed for the feature class that are not listed for the data.canterburymaps.govt.nz:layer-7494 layer name
in the DescribeFeatureType response. This (layer-7494) layer name corresponds to the
Clean_Air_Zones title and thus the Clean_Air_Zones feature class served in GeoMedia. The five
attribute names and corresponding type that seem to have been added by the data server are…
gml_description Memo gml_name Memo location_nilReason Memo Shape_nilReason Memo
Shape_owns Boolean If you request the DescribeFeatureType document using the URL below and
review the element-name list you will see that the attributes listed are not present for ‘layer-7494’.
https://data.canterburymaps.govt.nz/services%3Bkey%3D2452782855cd4b9bb7ad10c65876bc99/wfs/l
ayer-7494?service=WFS&request=DescribeFeatureType&Typename=layer-7494 If you attempt to use
Output To Feature Classes to output Clean_Air_Zones to a new feature class in SQL Server ReadWrite or Access connection the OTFC will fail with an entry written to GMOTTS.log for each of the 8
records in the feature class with a message like the following… Error: Unable to get the value of
location_nilReason ( Error message: ) where rid = layer-7494.42 Similar errors occur for
Shape_nilReason, and Shape_owns. Therefore the only way to successfully output the
Clean_Air_Zones feature class is to exclude the attributes location_nilReason, Shape_nilReason, and
Shape_owns use the ‘Select Source Attributes’ dialog from the Advanced tab of Output To Feature
Classes.
Customer has pointed out that example link for the REPLACE function incorrectly links to an example
for FORMATATTRIBUTE function.

In the GeoMedia Object reference.chm guide there is not ProgID for SQL Server Native Spatial RW
data server listed in the GDatabase list of Type property for the Connection object. Please update the
documentation to include this as it is now coming in the installed Desktop product and is no longer an
add on install.

GeoMedia fails to
serve GML file that
can be opened
successfully with
other GML clients

A customer provided an INSPIRE compliant GML file that cannot be served with the GeoMedia Desktop
2015 GML data server. When a GML connection is attempted the connection fails with the error
message:

00022
125

GeoMedia fails to
connect to GML file
that other clients
can serve
successfully

When attempting to connect to the customer provided ‘Geometry_CaseID100093802_med_xsd.gml’
using the GML data server the connection fails with the error message:

00020
104

GML Connections
Consume
Unreasonable

00012
194

February 13, 2018

“Error loading schema. Could not find file at the schema location :
http://inspire.ec.europa.eu/schemas/base/3.2/BaseTypes.xsd urn:xinspire:specification:gmlas:HydroPhysicalWaters:3.0”

"Reference to undeclared namespace prefix: 'gml'.”

Creating a simple GML connection consumes so much memory that the usefulness of GML data server
to serve large GML files and/or serve data from multiple GML connections is severely limited.
Connecting to a 500mb gml file (containing a single feature class) causes the GeoMedia.exe to
increase by approximately 1 GB. The memory use occurs after selecting OK on the connection dialog
(no record sets have been requested) which is highly unusual when compared to other data servers.
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00014233

Amounts of
Memory

The memory use nearly doubles again if the user then attempts to display the feature class from the
GML connection!

Can't open a WFS
service
(geoservice.plansy
stem.dk)

This service
http://geoservice.plansystem.dk/wfs?service=WFS&Request=GetCapabilities
..can't be opened in GeoMedia via WFS read-only connection. Attempting to connect in GeoMedia
results in the following error:

00010
083

Schema declaration for namespace 'http://geoservice.plansystemdk.dk/lpd' is not found.

00006
141

Unable to display
features (geometry)
from WFS from
Norwegian
mapping authority

Several WFS 2.0 services set up by the Norwegian mapping Authority will not display the geometries in
GeoMedia. The log file gdowfs.log does not report any problems. And we can display the attribute data
in the data window.

GEOMEDIA IMAGE PROFESSIONAL
CR #

IG-6561

Summary
Image Enhancement toolbar
does not function on images
added to map window using
GeoMedia > Manage Data >
APOLLO Explorer > right-click
> Add Image to Map

IG-4532

ILTP > Products > Import Copy
of Template crashes with
template containing Lookup
Labels and/or Geographic
Grids

IG-6154

Image Light Table Plus 2016 is
not supporting ECW Version 3
16-bit imagery

IG-6119

Image Enhancement toolbar
disabled when an ECW
Version 3 image is selected in
GMIP map window

Description / How to Reproduce
Image Enhancement toolbar does not function on images added to map window
using GeoMedia > Manage Data > APOLLO Explorer > right-click > Add Image to
Map

If you want to create a report using the Import copy of Template functions ILT
crashes. If you just open the template or create a new one it’s ok.

Customer reports that when opening any ECW V3 16-bit image in ILTP 2016, it is
showing only 8-bit and is not showing the proper image parameters. The image
display is hazy with different colors than original image (corrupt display).

For any image 8-bit or 16-bit ECW Version 3, the Image Enhancement toolbar is
disabled in GMIP map window.
Worfklow > Select image > ImagePro > Image Enhancement toolbar > all options
are disabled by default when any ECW v3 image is selected.
Image Enhancement toolbar is working fine for ECW V2 images.
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GEOMEDIA GEODEX
CR #

Summary

Description / How to Reproduce

None

GEOMEDIA 3D
CR #

Summary

Description / How to Reproduce

1-KHTL8G

Insert 3D Mesh Layer fails to
display in 3D map window

The customer is not able to Construct 3D Mesh. Memory management was enhanced to
address the problem.

1-B6UKYA

GML import results in Import
Aborted message

Large GML files were causing the process to run out of memory and crash.

1-K8OA1D

Import of GML file never
completes

GeoMedia 3D Import of GML file never completes. Problem is due to a combination of
large size and data containing umlauts.

1-U5ALTF

Import of KML/KMZ file fails
due to umlauts

The customer is not able to import the KMZ data. Umlauts are causing the issue.

CityGML building entrances
display abnormally in GM3D
map window

3D CityGML building entrances display abnormally in GM3D map window. The CityGML
model is created using Tridicon's utilities.
The customer generates CityGML building models in the format of *.tdc using Tridicon's
"tdc2CityGML" tool with Input is a *.tdc file and Output is a CityGML model.

1-M0IY6U

Then, import the CityGML file to GeoMedia 3D by using "Import 3D Objects" tool.
Then, load the 3D model in the GeoMedia 3D map window which results in the entrances
of buildings displaying in Red-colored textures using GM 3D 2015, and in GM 3D 2016
most all the Red-colored textures are gone, but a couple of building entrances have a
grey color displayed.
Import 3D Objects using
SketchUp file successfully
imports but does not display in
3D map window

1-K1PFTD

Import 3D Objects using SketchUp file successfully imports but does not display in 3D
map window.
1)
2)
3)
4)

SketchUp files were imported successfully using Import 3D Objects utility.
A new table was created in the corresponding warehouse.
Table contains only 1 record, but no geometries.
No obvious problem listed in the log file.

SketchUp file displays fine in SketchUp Viewer.

1-8WOUF3

Transformation Failure of ECW
when Toggle 3D - custom
named datum

Customer uses custom coordinate system based on custom named. When toggling to 3d,
there is a shift between the vector and the Raster (tried only ECW data). The .ecw file
does not respect the named datum, while the vector does.
Customized datum and coordinate system are used. Copy provided autodt.ini and
NamedHDatum.ini to the correct folder. Open provided .gws, restore connection to
provided shapefile data (edit the Test3D -ITM_DATUM.ini appropriately). Restore
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connection to provided .mdb file. Use Manage Data > Images to correct path to provided
.ecw image.
Two 2D views are displayed. Toggle 3D for right view. Notice image registration is lost image moves ~100meters WSW.
Import 3D Objects fails using
Tridicon City GML model with
"'System.Out Of Memory
Exception"

Import 3D Objects fails using Tridicon City Discover Light City GML model with "'System
Out Of Memory Exception" in log file. The raw 3D model originally in 3DS format was
converted to City GML data format using Tridicon software.

3D Import locks up when
importing large GML file

The import utility locks up when importing City GML files bigger than 100 MB. The
process works fine for some minutes (FME.exe and Import Utility are both using RAM
and CPU). After some time, the FME process no longer uses CPU and nothing happens
anymore. When closing the Import Utility dialog by clicking on the "X" button to exit the
utility, the FME process in the task manager is still there and starts working again until
FME process is finished. It appears in the export folder. Files are missing, and the export
is not complete.

Import of KML files fails

The input files indicated that they are UTF-8 character encoded when in fact they are
Latin-1 encoded. An option has been added to the Import 3D Objects command to allow
the importation of Latin-1 (ISO-8859-1) character encoded input.

Import of KML files fails to
display textures in 3D window

There was a problem with donut face conversions. This issue has been fixed.

Import of KMZ files fails

The input files indicated that they are UTF-8 character encoded when in fact they are
Latin-1 encoded. An option has been added to the Import 3D Objects command to allow
the importation of Latin-1 (ISO-8859-1) character encoded input.

1-M2R33J

Import from Tridicon random
features are missing textures

Features with donut faces sometimes fail to import. This has been fixed.

1-KR01JN

Errors importing large data set
from Fort Saskatchewan

The Import 3D Objects command runs to completion, but with errors. When viewing the
data in the 3D view, there are no textures on the buildings/structures.

Error Importing 3D Objects
with Collada data

Customer is trying to ingest 3D KML/Collada Objects into GeoMedia 3D using the Import
3D Objects Utility. Even if the customer can successful import the KML data, all the 3D
objects are discarded.

3D Installs incorrect version of
Define Coordinate System

The 2016 version of this utility has a key-in field displayed on the General tab labeled
"Coordinate reference system authority" which allows the user to key in an EPSG code to
define a CSF.

1-KUYAQL

1-JF09SZ

1-K1PFVC

1-9NZG2G

1-B5TFZ1

1-XPV9KV

At this point, a look in the c:\program files\common files folder shows no sub-folder
labeled 'Intergraph'.

1-U2T1VD

If GeoMedia 3D is then installed, there is a new folder: c:\program files\common
files\Intergraph. In one of the sub-folders is a new, 64-bit version of the Define
Coordinate System File utility. This version of Define CSF is incorrect/out of date. It also
changes the default association for .csf files, such that double clicking on a .csf now
brings up the 64-bit version.
The 64-bit version delivered with GM3D does not have the "Coordinate reference system
authority" key-in field.
Removing GeoMedia 3D from the system removes the 64-bit executable, but it also
removes the application association of .csf files. Double-clicking on .csf file now brings
up Windows dialog asking the user what application should be used to open the file.
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3D - City GML file displays
spatially incorrectly based on
EPSG 31467

City GML file displays spatially incorrect based on EPSG 31467 or without EPSG
code.
City GML data set is attached.
1)
2)
3)
4)

1-K1N0SA

City GML were imported successfully.
A new table was created in the corresponding warehouse.
Table contained a meaningful number of records.
But, the objects are not shown in the correct position (shift of more than
1000km).

The data should be somewhere in southwest Germany. After the import, the data
are somewhere near Kazakhstan.
Insert Hexagon Point Clouds
command Search option fails
on some files

1-LG90HN

To reproduce this problem:
1) Start GeoMedia in a workspace with at least one read-write warehouse
connection.
2) From the 3D ribbon bar, run Hexagon Point Clouds->Insert command.
3) Click the Search button.
4) Enter "\\hgdfileserver\serenity\Products\GeoMedia3D\Data" as the search
folder.
5) Click the Start Search button.
6) After the search is completed, notice that four of the files found have the
following message in the Projection field: "Unable to create the coordinate
system object."
Note: using the Add button to select these HPC files works correctly and retrieves
the coordinate system.

Default_Internet.fly can be
overwritten

Initially, user has a Geoworkspace with Default_Internet.fly set as base content
file. After using Default_Local.fly due to lack of internet connectivity, the
Default_Internet.fly file is changed/overwritten in some way - the file gets the
current date and does not work anymore. It does not fetch the globe from the
Terragate Server. Although internet connectivity is given, it behaves like the
Default_Local.fly.
To reproduce or see attached document results:
1) Open a GeoWorkspace with Default_Internet.fly as base content file and
internet connectivity (license server).
2) Close the GeoWorkspace.
3) Disable internet connectivity (need node lock license) and open the
GeoWorkspace again.
4) Toggle to 3D map window without internet connectivity and Default_Internet.fly
set as base content file. The Default_Internet.fly file becomes overwritten.
5) Choose Default_Local.fly file as base content file, save, and close the
GeoWorkspace.

1-TCMCIX

Reconnect machine internet connectivity again and open the GeoWorkspace.
Change the base content file from Default_Local.fly to the overwritten
Default_Internet.fly file. See the display result in the attached document.

IG-3200

Problem trying to use Motion
Video Analyst while GeoMedia
1.
3D is installed
2.
3.
4.

To reproduce this problem:
Start GeoMedia in a workspace with multiple map windows.
Click on the title bars of different map windows to change the active map window.
Display the Video Center dialog and change the video map window setting.
An error message will be displayed indicating that a COM object has been
separated from its underlying RCW.
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If GM3D is uninstalled (or its startup command is disabled in the registry), then
the workflow steps above will work correctly.

Grid > Calculator does not
process 'byte' data type
correctly.

5.

6.

IG-5897

7.

Customer provides .mdb file (attached) with a single area feature. Feature
attribute 'ls_geo_strrength' has 2 possible values (32 & 35) stored as 'byte'.
Customer wishes to create a grid with grid cell values equal to this attribute.
After displaying customer data, a Grid study area was created around the data.
The 'Rasterize Legend Entry' was run on the area feature. Then, the Calculator
was used, selecting the 'Geomaterials_Mapunits' feature, the 'ls_geo_strength'
attribute, multiplied by 1. The output grid contained only null (fill area) 32 and 35
as the values, but the output was identical to the input grid.
Testing with a simplified data set (byte value attributes) that is processed in a
similar manner shows the same error occurs, but if the attribute is of type integer,
the output reflects the desired attribute values. Also, creating a functional attribute
query of the customer's data where the attribute is cast to integer and the same
workflow applied to the result produces the desired output.
This workaround (using integer type instead of byte) was provided to the
customer. The customer changed the attribute to integer in SQL and found the
command worked without error.

DEPRECATED
WINDOWS 8
The Windows 8.0 and 8.1 operating systems are no longer supported.

ABOUT US
Hexagon Geospatial helps you make sense of the dynamically changing world. We enable you to envision,
experience and communicate geographic information. Our technology provides you the form to design, develop
and deliver solutions that solve complex, real-world challenges. Ultimately, this is realized through our creative
software products and platforms.
CUSTOMERS. Globally, a wide variety of organizations rely on our products daily including local, state and
national mapping agencies, transportation departments, defense organizations, engineering and utility companies,
and businesses serving agriculture and natural resource needs. Our portfolio enables these organizations to
holistically understand change and make clear, reliable decisions.
TECHNOLOGY. Our priority is to deliver products, platforms and solutions that make our customers successful.
Hexagon Geospatial is focused on developing technology that displays and interprets information in a
personalized, meaningful way. We enable you to transform location-based content into dynamic and useable
business information that creatively conveys the answers you need.
PARTNERS. As an organization, we are partner-focused, working alongside our channel to ensure we succeed
together. We provide the right platforms, products, and support to our business partners so that they may
successfully deliver sophisticated solutions for their customers. We recognize that we greatly extend our reach and
influence by cultivating channel partner relationships both inside and outside of Hexagon.
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TEAM. As an employer, we recognize that the success of our business is the result of our highly motivated and
collaborative staff. At Hexagon Geospatial, we celebrate a diverse set of people and talents, and we respect
people for who they are and the wealth of knowledge they bring to the table. We retain talent by fostering individual
development and ensuring frequent opportunities to learn and grow.
HEXAGON. Hexagon’s solutions integrate sensors, software, domain knowledge and customer workflows into
intelligent information ecosystems that deliver actionable information. They are used in a broad range of vital
industries.
Hexagon (Nasdaq Stockholm: HEXA B) has more than 18,000 employees in 50 countries and net sales of
approximately 3.3bn USD. Learn more at hexagon.com and follow us @HexagonAB.
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the Trademarks Page for information about the countries in which the trademarks are registered.
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PLEASE READ THESE TERMS CAREFULLY BEFORE USING HEXAGON GEOSPATIAL’S DOCUMENTATION ("DOCUMENT"). USE OF
THIS DOCUMENT INDICATES ACCEPTANCE OF THIS AGREEMENT WITHOUT MODIFICATION. IF YOU DO NOT AGREE TO THE
TERMS HEREOF ("TERMS"), DO NOT USE THIS DOCUMENT.
Use Of This Document
All materials in this Document are copyrighted and any unauthorized use may violate worldwide copyright, trademark, and other laws. Subject
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authorize you to reproduce this Document solely for your personal, non-commercial use. In consideration of this authorization, you agree to
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IN AN ACTION IN CONTRACT OR TORT, ARISING FROM YOUR ACCESS TO, OR USE OF, THIS DOCUMENT.

February 13, 2018

71

Copyright

Indemnification
You agree to defend, indemnify, and hold harmless Hexagon Geospatial, its officers, directors, employees, and agents from and against any
and all claims, liabilities, damages, losses or expense, including reasonable attorneys fees and costs, arising out of or in any way connected
with your access to or use of this Document.
Use Of Software
Use of software described in this Document is subject to the terms of the end user license agreement that accompanies the software, if any.
You may not download or install any software that is accompanied by or includes an end user license agreement unless you have read and
accepted the terms of such license agreement. Any such software is the copyrighted work of Hexagon Geospatial, Intergraph or its licensors.
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Hexagon Geospatial reserves the right to revise these Terms at any time. You are responsible for regularly reviewing these Terms. Your
continued use of this Document after the effective date of such changes constitutes your acceptance of and agreement to such changes.
Applicable Law
This Document is created and controlled by Hexagon Geospatial in the State of Alabama. As such, the laws of the State of Alabama will govern
these Terms, without giving effect to any principles of conflicts of law. You hereby irrevocably and unconditionally consent to submit to the
exclusive jurisdiction of the United States District Court for the Northern District of Alabama, Northeastern Division, or the Circuit Court for
Madison County, Alabama for any litigation arising out of or relating to use of this Document (and agree not to commence any litigation relating
thereto except in such courts), waive any objection to the laying of venue of any such litigation in such Courts and agree not to plead or claim in
any such Courts that such litigation brought therein has been brought in an inconvenient forum. Some jurisdictions do not allow the exclusions
or limitations set forth in these Terms. Such exclusions or limitations shall apply in all jurisdictions to the maximum extent allowed by applicable
law.
Questions
Contact us with any questions regarding these Terms.
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